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Before You Begin
Trimble Connect is a collaboration tool that connects the right 
people to the right constructible data, at the right time.
With Trimble Connect you can work anytime, anywhere and from any device – it’s at your 
fingertips. You are always working with reliable and accurate information. Trimble Connect 
can be used in different phases of workflows, such as design coordination and review, on-
site and off-site communication, and when managing activities and tasks during the entire 
project.

You can share 3D models, drawings and other documentation: View, review, reference and 
archive with revision history. Trimble Connect has easy-to-use user interfaces for desktop 
and mobile (both iOS and Android) and even on Mixed Reality (MR) devices. The platform 
helps you maintain control over changes thanks to constant collaboration, so that costly 
rework caused by outdated information becomes an inconvenience of the past.

Trimble Connect links data throughout each phase of the building life cycle to keep your 
project on schedule and on budget. You can upload and share documents from over 60 
industry tools, or add your own source using the powerful API (Application Programming 
Interface). Trimble Connect and workflow tools are available in 17 languages.
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Connect Licensing
Connect has 5 main levels of licensing which will give you access to certain areas in the 
application. Using Trimble Connect requires an active license. Learn more about our 
purchasing options here.

PERSONAL BUSINESS PREMIUM PROJECT ENTERPRISE

Project Creations 1 Unlimited Unlimited 1 Unlimited

Total Storage 10 GB Unlimited Unlimited Unlimited Unlimited

Max File Size 
Upload1 10 GB 10 GB 100 GB 100 GB 100 GB

Project Joins 52 Unlimited Unlimited -- Unlimited

Clash Detection � � � � �

Task Mgmt � � � � �

Custom File 
Attributes -- � � � �

Workflow 
Extensions Read-only Read-only Full access Full access3 Full access4 

Overview & 
Mgmt Users -- Enabled for 

Act. Admin
Enabled for 
Act. Admin

Enabled for 
Act. Admin

Enabled for 
Act. Admin

Overview & 
Mgmt of Projects -- Enabled for 

Act. Admin
Enabled for 
Act. Admin

Enabled for 
Act. Admin

Enabled for 
Act. Admin

1	 Max file size upload per file using Trimble Connect Sync.
2	 Personal license users can join up to 5 Personal or Business projects with full business access, after the limit is reached, 

users will have read-only access. Personal license users can join unlimited Enterprise Projects.
3	 Full access for everyone on your project, including external users outside your organization.
4	 Full access for everyone in your account as well as external users on projects created under your account.

https://connect.trimble.com/storefront
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Understanding Project Types & Features  
Project type and Connect licenses go hand-in-hand. When you create a project, the license 
that is assigned to you also gets applied to the project. Some features may be restricted 
based on the license that is associated with the project. 

As a general rule of thumb, the following is a breakdown of the type of project that is created 
based off the license that is used/assigned to the project:

Personal License Personal Project

Business License Business  Project

Bus. Premium Lic. Business  Project

Enterprise License Enterprise Project

Project License Enterprise Project

Available Features by Project Type

PERSONAL PROJECT BUSINESS PROJECT ENTERPRISE PROJECT

Storage 10 GB Unlimited Unlimited

Project members 5 total5 Unlimited with some 
license restrictions6 

Unlimited - no  
license restrictions7

Project invitations 5 total8 Unlimited Unlimited

Workflow 
Extensions

Available for users 
with Bus. Premium9 

Available for users 
with Bus. Premium9 

Full access for all 
project members

5	 The number of project users includes removed users. Trimble Connect doesn't support re-inviting removed users to a 
project with a free license.

6	 Personal license users can join up to 5 Personal or Business projects with full business access, after the limit is reached, 
users will have read-only access. 

7	 Personal license users can join unlimited Enterprise Projects.
8	 The number of project invitations includes re-inviting removed users to a project.
9	 Users with a Business Premium license can collaborate in all project types and be able to use all the Workflow 

Extensions. If other members in the project do not have Business Premium, they will have Read-only access to any data 
created and stored in the Organizer or Property Set Service.
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View & Manage Licenses
There are two places Trimble Connect paid licenses can be managed, the Trimble Account 
Management Portal or the Tekla Online system. You can quickly access either system 
directly in the Trimble Connect for Browser application by opening the User () dropdown 
menu, where you will see options for My Trimble Subscriptions and/or My Tekla Online 
Subscriptions.

Note: Users with Personal licenses only will not see either of these menu options.

Trimble Account & Trimble Subscriptions
Business licenses for Trimble Connect can be purchased directly from the 
Connect Storefront, via your Trimble Sales Rep or as part of a bundle with other Trimble 
Applications.

1.	 After purchasing your license, you will receive an entitlement letter by email.

2.	 Now you have access to Trimble Account Management Portal that allows you 
to manage your subscriptions: change plans, add/remove seats, and adjust auto-
renewal settings.

Tekla Online Subscriptions
With one license, you have access to full Trimble Connect functionality and Tekla Structures 
Workflow Tools. See the phases of managing licenses.

1.	 After purchasing your license, you receive an entitlement letter by email. 
Now you have access to Tekla Online Admin tool that allows you to manage your 
organization's users access rights to Tekla Online services.

2.	 Invite users to your Tekla Online services organization to grant them Trimble Connect 
licenses. For more information about inviting users, see Trimble Identity FAQ.

For more information about managing licenses in Tekla Online Admin Tool, see 
Manage Trimble Identities and Tekla Online licenses.

https://connect.trimble.com/storefront
https://ecom-prd.trimblepaas.com/account/organization
https://admin.account.tekla.com/
https://teklastructures.support.tekla.com/not-version-specific/en/trimble_identity_faq
https://teklastructures.support.tekla.com/not-version-specific/en/managing-tekla-accounts-and-model-sharing-licenses
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Check for an Updated License
When a new Connect license is applied, you can make it available faster (on demand) using 
the new “Check for updated license” option in the User dropdown menu.

Update a Project License Updated 
If you have recently been assigned a new license and want to change the license that is being 
used on one or more of your projects, you can update the project license by going to the 
Trimble Connect for Browser application, and updating the project ownership and/or project 
license in the Project Details page. 

Changing the project ownership will change the ownership of the project to the new account. 
Any existing file metadata being used on the project will be removed and will be replaced by 
the new account owner’s file metadata template (if the new account is using the feature).

If the license you are trying to use comes from the same account, the ownership of the 
project will remain the same. 

Note: This is a Project Admin function only and not available to all project users.
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To update a project license New

1.	 Start by going to Trimble Connect.

2.	 Open the project. 

3.	 Go to the Settings › Project Details page.

4.	 Select the correct account from the Project ownership dropdown.

a.	 If you only have licenses from one account, this field will not be editable.

5.	 Select the correct project license from the Project license dropdown.

a.	 Only licenses from the chosen account will be listed.

b.	 If you only one license from an account, this field will not be editable.

6.	 Click Save changes.

https://web.connect.trimble.com/
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Managing Your Trimble Account & 
Connect Profile
You'll need your Trimble ID to log into any of the Trimble Connect applications. 

Creating Your Trimble ID
If you are new to Connect, and have never signed up for any other Trimble applications 
before, you will first need to create a Trimble Identity User Account, which you can use to 
sign in to any Trimble application, including Trimble Connect. 

1.	 Start by going to Trimble Connect

2.	 You will be asked to sign in to your Trimble Account 

3.	 Click Create new Trimble ID to create a new account

4.	 You will be taken to the Create your account page

5.	 Enter your name, email address, and password. Click Create new account

6.	 You will be asked to confirm your email

7.	 Go to your inbox and open the confirmation email. Click Activate

https://web.connect.trimble.com/
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8.	 You can now sign in to your account

9.	 Once you sign in to your account, you will be asked to complete your Connect Profile 
(covered in the next section)

IMPORTANT NOTES

Email Address This must be a unique email address and cannot be associated to 
any existing Trimble Accounts. If you get an error that the email 
address is being used already, you can go through the Forgot 
Password flow to reset your password if you have forgotten it.

Password Passwords must contain
•	 8 Characters
•	 A digit [ 0-9 ]
•	 A combination of lower & uppercase letters [ aA-zZ ]
•	 A special character [ !@#$%&*^_-+ ]



﻿Trimble Connect for Windows  ›  Managing Your Trimble Account & Connect Profile 9

Creating Your Connect Profile
If you are signing in to Connect for the first time, you will be asked to complete your Connect 
profile before you can continue.

Once you have completed this step, you will be taken to the Projects page where you can 
now start using Trimble Connect!
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User Profile Information Updated 
Your full Connect profile can be accessed from the My Profile page in the 
Trimble Connect for Browser application. It contains the below information.

Basic Information

Profile Photo This will be displayed in Connect projects on the Team page.

First & Last Name Choose how you want your name to be displayed inside Trimble 
Applications.

Email Address You cannot change an email address tied to an existing TID 
account. You will need to create a new account to use a new email 
address.

Password Update your password for your account.

Contact Information

Work phone Add your work phone number 

Mobile phone Add your mobile phone number

https://web.connect.trimble.com/
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Preferences

Language Connect can be translated into 17 different languages. 

For more information see 
Trimble Connect Supported Languages 

Country Select your country. This option will filter out the available time 
zones listed.

Time zone This is used for showing the timestamps localized to where you are.

Work

Employer Add your Employer name. This will be shown inside projects on the 
team page and activity page. 

Job Title Choose from a predefined list of options of type your own.

Linked Accounts New 
All accounts which have assigned you a license or that you are an Admin for will be listed 
here. Please contact the corresponding Account Admin if you need to be unassigned a 
license from that account. 

https://drive.google.com/file/d/15PeFaKqX_w2CMfmP8GodwQk0CWcfFujx/view?usp=sharing
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Update Your Profile & Preferences 
You can update various parts of your user profile by going to the My Profile page in the 
Trimble Connect for Browser application. 

To update your profile:

1.	 Log in to your account in the Trimble Connect for Browser application.

2.	 Click on the User dropdown menu (located in the application header).

3.	 Click My Profile.

4.	 Edit the desired fields.

5.	 Once you are finished, click the Save button. 

All of this information is part of your Trimble Identity User Account (also known as TID—
which includes your user name and password credentials).

https://web.connect.trimble.com/
https://web.connect.trimble.com/
https://identity.trimble.com/userprofile/
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Installation Guide

Installation

Download Trimble Connect for Windows
After you have signed up for Trimble Connect, you will be able to access the 
Trimble Connect App Store, where you can download the Trimble Connect for Windows 
installation file.

You don't need to delete previous versions of Trimble Connect before installing either a new 
Trimble Connect or an update of an already-installed version of Trimble Connect.

Check to see if your device meets our System Requirements 

https://web.connect.trimble.com/#/store
https://drive.google.com/file/d/1IlZvRqpmCC-ZM7-bpaGbK-TNbhjwG54P/view?usp=sharing
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Installing Trimble Connect for Windows
1.	 Before Trimble Connect for Windows can be installed, you first will need to install 

different plugins in order to read various files types while using Trimble Connect for 
Windows.

2.	 Once the plugins are installed, the Trimble Connect for Windows installation will 
start.

3.	 Next you will be asked to accept the license agreement.
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4.	 Next you can decide to install Trimble Connect for Windows to a non default location 
(C:\Program Files\Trimble\Trimble Connect\).

 

5.	 You will then be asked which files should automatically be opened in Trimble 
Connect

6.	 Trimble Connect for Windows will then be installed.
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Admin Installation
Administrative installation of Trimble Connect for Windows allows company IT 
administrators to distribute and install Trimble Connect to their users in a centralized way. 
This is necessary when user rights prevent users from self-installing the software and when 
company IT administrators want to manage the usage of software versions in their domain.

The installer requires administrative rights. Trimble Connect for Windows interface is meant 
to be installed to all users, and per-user installation is not allowed. If you use the command 
line to set ALLUSERS="", the installer will override the setting and it is set to ALLUSERS=1.

Distribute Trimble Connect for Windows
1.	 Download the latest installer

a.	 Sign in to Trimble Connect
b.	 Download Trimble Connect Desktop from the Trimble Connect App Store, 

found in the top right corner after signing in.

2.	  Verify the installer

a.	 Open the installer properties, check the Digital Signature, and make sure it is 
signed by Trimble Solutions Corporation.

b.	 Create a folder for prerequisites (d:\preq is used in this example).

c.	 Create a folder for Trimble Connect Desktop installer (d:\installer is used in 
this example).

3.	 Extract installer files

a.	 Open the command line (cmd) and navigate to the folder where the Trimble 
Connect for Windows installer can be found.

b.	 Execute the command:  
TrimbleConnectSetup-VersionNumber-x64.exe /ad:\preq  
The installer starts running.

c.	 Installation wizard will ask to specify the folder for the installer, use d:\
installer and finish the installation.

4.	 Distribution

a.	 Now you should have all prerequisites under the folder d:\preq, each in its 
own subfolder.

b.	 In the d:\installer folder is found the Trimble Connect.msi, as well as the 
folder content for program files and program data. When running the msi 
installer, it will install the folder structure and files under program files. It is 
suggested to use the .msi installer instead of copying the folder structure.

c.	 Now you can use your distribution process for all these files.

https://web.connect.trimble.com/
https://web.connect.trimble.com/#/store
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Update Installation
When a new version of Trimble Connect for Windows is available, a message will be shown in 
the top right corner of the application, informing you that a new version is available and can 
be downloaded and installed. This message will remain displayed until you have updated 
your version of Trimble Connect for Windows.

To Update the Application 

1.	 Click New versions available!

2.	 You will be asked to choose the folder you want the installer to be downloaded in. 
Click Ok.

3.	 The download will start. 

4.	 Once the new installer is downloaded, a dialog appears in Trimble Connect for 
Windows application, giving the user the opportunity to install the new Trimble 
Connect for Windows version now or later.

5.	 Click Install now.

6.	 Trimble Connect for Windows will close and the install wizard will walk you through 
the process.

Uninstall Trimble Connect for Windows
When uninstalling Trimble Connect for Windows, only the software is uninstalled, not the 
plugins that were installed with it. These plugins might be used by other software such as 
Tekla Structures. They need to be removed one by one manually to be uninstalled.
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Starting Trimble Connect with Command Line
Trimble Connect for Windows can also be started using a URL either in the command line, or 
using an Internet browser if needed. The supported URL format is:

trimbleconnect:/projects/[project-id]?show=[view parameter],[panel parameter]

Parameters
•	 Supported view parameters: projects, data, 3d (default is data)

•	 Supported panel parameters: clashes, models, objects, ToDos, views (default is 
models)

•	 These parameters are case insensitive.

Example: trimbleconnect:/projects/rQR1yhTGj9I?show=3D,ToDos

In that example, at start, Trimble Connect for Windows would open at the project 
rQR1yhTGj9I 3D view, with the ToDos tab shown instead of the models tab.

BIMsight Package
Bimsight TBP package can be added from tekla BIMsight directly to Trimble Connect for 
Windows, by simply drag and dropping the tbp package into Trimble Connect for Windows 
library. 

When doing so, a new unpublished project is created in Trimble Connect for Windows, with 
the same name and thumbnail than the BIMsight project. All models, and model folders are 
created accordingly in the Trimble Connect for Windows project. All models still have their 
former alignments. Other files (non-models) found in the project are added in a new folder 
created automatically and called Documents.

The project can be published whenever it is wanted.
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Getting Started

Sign In to Your Account
After starting Trimble Connect for Windows for the first time, you will be asked to sign in to 
your Trimble Account. 

More information on Trimble Accounts can be found in the 
Trimble Connect for Browser User Guide 

https://drive.google.com/file/d/15OzgnJ29b0PCXyXL9xyZpMIBBuGHMBOm/view?usp=sharing
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User Menu

OPTION DESCRIPTION


Opens the User menu 

User Email Users can go to Trimble Connect for Browser by clicking on his 
Connect email address.

Sign Out You can also sign out of the application, which will close any open 
project, and take you back to the sign in screen, where you will be 
asked to input your credentials. 

Once a user has signed in and checks the stay signed in checkbox, 
he can then use Trimble Connect for Windows even if he loses 
Internet connection, as long as he doesn’t sign out. All changes will 
be synchronized to the server when Internet connection has been 
restored.
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Help Center

OPTION DESCRIPTION

 Help center can be found in the upper right corner of the Trimble 
Connect for Windows window.

When clicking the help center button, the Help menu appears:

Need Help? Clicking Need Help? opens the help center home page in the default 
browser. User documentation about Trimble Connect, news and 
announcements, and most commonly asked questions can be found 
in the help center.

EULA Clicking EULA opens the help center terms of services in the default 
browser.

Privacy Clicking Privacy opens Trimble's Commitment to Online Privacy web 
page in the user's default browser.

About Clicking About opens the About Trimble Connect dialog, where 
you can find the Trimble Connect for Windows version and other 
information.
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Application Settings
All settings are applied instantly, except for the graphics and language settings, which  
require Trimble Connect for Windows to be restarted. Settings are saved and remain the 
same even when closing the project or restarting Trimble Connect for Windows.

The language and server location settings are synchronized between the different Trimble 
Connect clients.

Open the Trimble Connect for Windows settings by clicking Settings (), found in the upper 
right corner of the application.

General Settings
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OPTION DESCRIPTION

User Interface Tablet vs. Normal Mode

When switching the interface to tablet mode, the all interface is 
adapted for usage on touch devices. It means that the buttons, scroll 
bars and tabs become wider to be clicked easily.

Navigation 
Controls Buttons

Navigation control buttons can be shown/hidden.

The navigation controls are found in the upper right corner of the 
3D Viewer. They can be used to change navigation mode, rotate the 
view, zoom in/out, and put the 3D view into fullscreen mode.

By default navigation control buttons are shown.

Show View Toolbar The View Toolbar (used in the 3D Viewer) can be shown/hidden.
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OPTION DESCRIPTION

Enable Highlighting Highlighting of objects in the model is enabled.

The highlight setting is disabled by default. If value off/on in the 
registry will be used.

When highlighting is disabled, hovering over an object will not 
highlight the object anymore and highlights for markups and grids 
will also be disabled.

If the CTRL key is pressed while hovering, the highlight will be 
enabled on the fly as long as the CTRL key remains pressed. As soon 
as the button is released, the highlight will be disabled again.

Point Clouds A new folder for point clouds conversion can be chosen.

The point clouds conversion folder is set to a default location, i.e:

C:\Users\UserName\AppData\Local\Trimble\Trimble Connect\
Import

Language You can define the language the application is translated in.

When changing the language, a dialog will ask you if you want to 
restart now or later. The chosen language will be applied only after 
restarting the software.

Default Server 
Location

The default server to load projects and create projects in can be 
defined.

When setting the server location, it will be remembered, and the next 
time the user creates a new project, it will use the chosen server.

•	 Default server location is set to the last chosen location. 

•	 Default server location setting is now used in automated 
project creation when opening model file(s) from windows 
explorer (ex: when a file is open with Trimble Connect for 
Windows, this will open in the default server location)
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Graphics

OPTION DESCRIPTION

Edge Lines Edge lines can be enabled/disabled.

SSAO SSAO can be enabled/disabled.

FXAA FXAA lines can be enabled/disabled.

Depth Peeling Depth peeling can be enabled/disabled.

Camera Animation Camera animation time can be set between 10-5000 / milliseconds 

Animation Quality Camera animation quality can be set to High/Medium/Low

Note

DirectX is used, with edge lines, SSAO and FXAA enabled.

DirectX is now the default and only available 3D engine. OpenGL is no longer supported in 
Trimble Connect for Windows starting from version 1.6.
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Proxy
Trimble Connect for Windows doesn’t use any proxy server.
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Projects

Managing Projects
When opening Trimble Connect for Windows, and after the user has signed in, the project 
library is shown. All projects the user has access to, i.e. all already downloaded projects, all 
projects the user created and the ones that have been shared with him will be listed on this 
page. 

Create a New Project
New projects can be created from the project library by clicking the New Project button. 

You can also choose not to publish the project (projects are published at creation by default). 
This means that the project will be only saved locally on your Windows machine until you 
decide to publish.

1.	 After starting Trimble Connect for Windows, click New Project in the upper-left 
corner of the application.

2.	 Type name for the project and select the project server location. 

3.	 If you have multiple licenses, select the correct license in the License list.

4.	 Choose if you want to publish or not publish a project.

5.	 Click Create project.
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Project Fields & Descriptions

OPTION DESCRIPTION

Project Server 
Location

The project server location setting is important as Trimble Connect 
servers are located in three different regions, North America, 
Europe, and Asia, to increase the performance for customers 
located all over the world. Select the region closest to you.

Note: The project server location cannot be changed once the 
project is created.

License Inside the dropdown menu, you will see a list of all licenses 
available for your Trimble Identity, along with the account 
information where the license comes from.  Select the license/
account you want the new project to belong to. The selection can 
be changed later in Project Details in the Trimble Connect for 
Browser application.

Note: Project ownership is determined by the project’s license 
which is applied during project creation. The account which owns 
the license is considered the project owner.

Do not publish To upload the project automatically to the server: 
Make sure the Do not publish checkbox is not selected. 
The project is only visible to you until you invite more users to the 
project.

To prevent uploading the project automatically to the server: 
Select the Do not publish checkbox. 
You can later upload the project to the server by clicking Publish 
under the project thumbnail.
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Project Tile Functions

OPTION DESCRIPTION

 Favorite Projects

Project can be starred by clicking the star under the project 
thumbnail. Stars can then be used to sort projects.

 Open the last 3D View

This will load the project directly in the 3D Viewer with the last saved 
view loaded. 

 Opens the Project Menu

Invite Users
If you have the permissions to do so, this will open the Invite User 
Dialog.

Set Project Image
A new project thumbnail can be set for the project by hovering over 
the project and clicking the select thumbnail button. Any (and only) 
picture file can be used as a thumbnail.

Delete project
Projects can be deleted by using the delete project button. When 
deleting a project, a user can decide to delete only locally or both 
locally and from the cloud if he is user admin. He can delete it only 
locally if he is a normal user.
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Project Statuses

OPTION DESCRIPTION

Project Synchronizing

Once a project has been created it will automatically appear in the 
user project library and is synchronized with the server. Every time 
synchronization with the server happens, the synchronization icon can 
be seen. Synchronization happens automatically at regular time intervals.

 Project Synchronized

When forcing the synchronization from the project library, only project 
entities are synchronized. This means that all items such as folders 
and ToDos will be synchronized, but the files and models won’t. To 
synchronize files, the user needs to open the project. For each project, 
once entities are synchronized, the next icon appears under the project 
thumbnail.

 Project Needs to be Downloaded

If a project has been shared with the user, but he didn’t download it yet, 
instead of a check mark is shown a download symbol. Clicking that icon 
will synchronize the project entities.

Publish
Unpublished Project

The project exists only locally and has not yet been uploaded to the 
server.

To upload the project on the server, click Publish.

 Project is Offline

Trimble Connect for Windows is in offline mode. All changes are 
synchronized when the Internet connection is available again.
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Delete a Project
You can delete Trimble Connect projects on your Windows computer or tablet only or from 
both the machine and from the cloud. 

If you delete a project locally, the project is only removed from your computer. However, if 
you delete a project both locally and from the cloud, the project will be deleted permanently 
for all users.

1.	 On the Trimble Connect for Windows Project page, click  at the lower-right corner 
of a project.

2.	 Select Delete project.

3.	 In the confirmation dialog box, select one of the following to delete the project:

a.	 Delete only on my computer: The project is only deleted on your computer. 
If necessary, you can download the project onto your computer again.

b.	 Delete project forever: The project is permanently deleted on your local 
computer and on the cloud.

More information on Project Management can be found in the 
Trimble Connect for Browser User Guide 

https://drive.google.com/file/d/15OzgnJ29b0PCXyXL9xyZpMIBBuGHMBOm/view?usp=sharing
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Project Sorting & Filtering

Sorting Projects
Sorting can be done in ascending or descending by clicking the arrows in the Sort by box. 
The blue arrow indicates the current sort order (ascending shown below).

Projects can be sorted from project library using the next properties:
•	 Name
•	 Last modified
•	 Last visited (default)
•	 Local/Cloud only
•	 Starred/Unstarred

Search for a Project
You can search through your project library by using the search field. Only projects matching 
the search criteria are displayed in the library. The search field is cleared by default when 
opening Trimble Connect for Windows.

Switch Project Views
The project library can also be switched between Tile View () and List View (). In list 
view thumbnails are smaller and projects are shown as a table. All project functionalities 
work the same. Project removal and thumbnail update functionalities are accessible through 
the right click contextual menu.
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Offline Mode
When losing Internet connection, Trimble Connect for Windows goes into offline mode. 
Trimble Connect for Windows can still be used offline, as all features except the project 
synchronization is enabled. All changes will be synchronized when Internet connection is 
restored. If a user adds files to a project while being offline, he can then upload them to the 
server manually after recovering Internet connection.

While being offline, the login button turns into a warning symbol , to indicate that the 
Internet connection has been lost. The warning symbol can also be seen under project 
thumbnails.

When opening a project in offline mode, it is also indicated in the Trimble Connect for 
Windows main title bar, where it says Project Name - offline. 

Also, when opening Trimble Connect for Windows while being offline, a dialog informs the 
user that Trimble Connect for Windows is going to be used in offline mode.
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Project Settings
To open the project settings in Trimble Connect for Windows click Settings () located in 
the right corner of the application. When clicking the icon while being inside a project, the 
application settings are also available in different tabs. 

Unit Settings
Set the standard units to be used throughout the project. Trimble Connect has expanded 
unit settings for the project system and allows users to specify display precision on each unit 
e.g. Length, Area, Volume Angle and Measurements Length. Unit setting support varies by 
application.
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Supported Settings

Unit System

BROWSER APP 3D VIEWER MOBILE APP WINDOWS APP

Metric � � � �

Imperial (decimal) � � � �

Imperial (fractional) � � � �

Custom � � � �

Display Precision

BROWSER APP 3D VIEWER MOBILE APP WINDOWS APP

0, 0.1, 0.01, 0.001 � � � �

½, ¼, ⅛, 1/16 1/32 1/64 � � � �

Distance

BROWSER APP 3D VIEWER MOBILE APP WINDOWS APP

Millimeter (mm) � � � �

Centimeter (cm) � � � �

Meter (m) � � � �

Kilometer (km) � � � �

Inch (in) � � � �

Foot (ft) � � � �

Yard (yd) � � � �
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BROWSER APP 3D VIEWER MOBILE APP WINDOWS APP

Ft-in � � � �

Mile (mi) � � � �

Area

BROWSER APP 3D VIEWER MOBILE APP WINDOWS APP

mm2 � � � �

cm2 � � � �

m2 � � � �

in2 � � � �

ft2 � � � �

yd2 � � � �

Volume

BROWSER APP 3D VIEWER MOBILE APP WINDOWS APP

mm3 � � � �

cm3 � � � �

m3 � � � �

in3 � � � �

ft3 � � � �

yd3 � � � �
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Weight

BROWSER APP 3D VIEWER MOBILE APP WINDOWS APP

Milligram (mg) � � � �

Gram (g) � � � �

Kilogram (kg) � � � �

Tonne (t) � � � �

Ounce (oz) � � � �

Pound (lb) � � � �

Short ton (sh tn) � � � �

Ton (ton) � � � �

Angle

BROWSER APP 3D VIEWER MOBILE APP WINDOWS APP

Degree (deg) � � � �

Radius (rad) � � � �
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Data Tab
When double clicking a project, it will open, and Trimble Connect for Windows will 
automatically go to the Data Tab, where they will find the project information and project 
content.

 

From the Data Tab, users can manage the project files and folders. After the project 
synchronization is complete, the project and it's content will also be available in other 
Trimble Connect applications. 

Project Details

Project details such as date of creation, creator and when the project was last modified can 
be found in the project details pane. The project thumbnail is also shown there.

Note: The project name is only editable by a Project Admin. 

OPTION DESCRIPTION

 All project entities can be synchronized using the Synchronize 
button.


To navigate back to the project library and close the project, click the 
back arrow found next to project details.
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Other Project Functions
On the upper right side of the Data Tab are buttons that allow to open quickly the project in 
Trimble Connect for Browser.

OPTION DESCRIPTION

View online
View Online - Open the project Data Tab in the Trimble Connect for 
Browser application.

Team Team button - Open the project Team tab in the Trimble Connect for 
Browser application.

Activity
Activity button - Open the project Activity tab the Trimble Connect 
for Browser application.

You can click the Activity tab in the project detail view to see all 
actions made since the project was created. For example, you can 
see when files have been attached or removed, or when users have 
been invited or have joined the project.

 Invite users to project - Invite new users to the project so that it is 
available for them in Trimble Connect.

Some projects may require more strict control for inviting users into 
the project. A Project Administrator can select the option to allow all 
users to invite new project members or restrict project invitations to 
Project Administrators only for enhanced security.

If a Project Administrator has restricted this functionality, the  
Invite user () button will be disabled.
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Invite Users
You can invite users in Trimble Connect for Windows by using the Invite user () button 
found in the Data Tab and in other places in the application. If the invited user already 
has a Trimble Account, they will receive an email with the project link. Otherwise they are 
instructed to create a new account. When the users have joined, they can access the project 
and the folders and the files to which they have permissions.

To Invite:

1.	 Go to the Data Tab page.

2.	 Click the Invite user () button at the top of the page. 
The Invite Users dialog box opens.

3.	 Enter the email of the user. 
You can enter multiple email addresses. Use semicolon (;) or comma (,) as a 
separator.

4.	 Select a Group and Role for the user. 
The role can be either Admin or User.

5.	 To send the invite, click Ok. 
The user receives an email with instructions on how to join the project.
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Project Member Invitation Settings
Some projects may require more strict control for inviting users into the project. A Project 
Administrator can select the option to allow all users to invite new project members or 
restrict project invitations to Project Administrators only for enhanced security.

This setting can be accessed in the Trimble Connect for Browser application.

If a Project Administrator has restricted this functionality, the Invite user () button will be 
disabled/not work.

More information on team management can be found in the 
Trimble Connect for Browser User Guide 

Explorer Pane
Project content is added and managed through the File Explorer.

Search the File Explorer
The File Explorer can be searched by using Search () located in the upper right corner.

When clicking Search (), text can be entered. Pressing enter validates the entry, and File 
Explorer turns into a flat list, displaying only the folders/files corresponding to the applied 
filters.

Existing tags are also available in the search dropdown to be picked. A combination of users, 
texts and tags can be used to cross filter the list and display only the files/folders matching 
the search criteria.

https://drive.google.com/file/d/15OzgnJ29b0PCXyXL9xyZpMIBBuGHMBOm/view?usp=sharing
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The icon in front of the currently active entries indicates if it is a text (), user () or a tag 
(), as seen above. Clicking Remove () on the end of the entry clears it. Clicking  
Remove () on the right side of the filter field clears all entries, and the File Explorer goes 
back to normal state.

When typing a new search, previously used text is proposed, so that it can be reused for 
subsequent searches.

Views Pane
When switching back from 3D to Data Tab, last view settings are saved and a View is 
automatically created in the Views pane. That View will be shown there until the user 
reopens the 3D Viewer. Clicking this view allows you to quickly go back to the last used 3D 
Viewer in order to be able to continue working where one left off.
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Add Views to the Views Pane
Users can decide to also add some existing Views from the Views Strip added to the Views 
pane. Existing Views can be added to the Data Tab using the context menu, Add to Data 
Tab. 

Open a Model 3D View
You can open the 3D Viewer with any of the Views shown in the Views pane. 

1.	 On the start page, click a project to open the project detail view.

2.	 Double click on a View listed in the View pane.

3.	 You will be taken into the 3D View with the View loaded. 

Remove a View from the Views Pane
Views can be removed from the Views pane by right clicking on a View and then selecting  
Remove from Data Tab from the context menu. 

The View will be removed from the Data Tab, but it will still exist in the Views Strip.
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ToDos Pane
ToDos created from any of the Trimble Connect applications are also listed in the Data Tab.

By default, the ToDos pane is filtered to only show the ToDos that are assigned to you. If 
needed, this can be changed using the Show dropdown, and the user can decide to change 
also only ToDos he created, or all ToDos in the project.

See "Working in 3D: ToDos" on page 124 for more information on using and creating 
ToDos in the Trimble Connect for Windows application.

ToDo Visibility 
ToDos can be made private or public to all users in the project. By default, ToDos are visible 
for all users in the project.

If you are a Project Admin, you can change the privacy settings by going to the Trimble 
Connect for Browser application › Settings › User Permissions page.
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Files & Folders 
You can upload and download both 2D files and 3D models in Trimble Connect for Windows. 
2D files can be photos, text files, excel sheets, documents, or other similar files.

Supported File Formats

For the full list of supported files - please see Supported File Formats 

Revit Importer
It is now possible to add Revit (.RVT) model files to the project and view them in 3D using 
the Connect for Windows application. Note that this feature is not intended to replace the 
Trimble Connect for Revit Add-On which gives you the most control over choosing which 
Views get uploaded along with other upload settings. This feature offers a quick, but less 
controlled, way of getting Revit models into Connect without having to install the Trimble 
Connect for Revit Add-On.

File & Folder Naming Conventions
All file & folders stored in Trimble Connect use the concept of files and directories to access 
data stored on a disk, device or server.

Due to certain operating system (OS) file name restrictions, do not use the following 
characters in file names:

•	 < (less than)
•	 › (greater than)
•	 : (colon)
•	 " (citation mark)
•	 / (forward slash)
•	 \ (backslash)
•	 | (vertical bar or pipe)
•	 ? (question mark)
•	 CHAR. (Characters followed by dot)
•	 * (asterisk)
•	 .. (double dot)

https://drive.google.com/file/d/1-vx8BgT1YfAjC2bi0LtFrj4Oww95pKnZ/view?usp=sharing
https://community.trimble.com/docs/DOC-10018-trimble-connect-for-revit
https://community.trimble.com/docs/DOC-10018-trimble-connect-for-revit
https://docs.microsoft.com/en-us/windows/win32/fileio/naming-a-file?redirectedfrom=MSDN#naming-conventions
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Add Local Files
Files can be added to the project by selecting a folder and clicking Add File (). 

•	 If no folder is selected, the file will be added to the root level of the project. 

•	 If a file is selected, the file will be added in the same folder/level as the selected file.

To add 2D files and 3D models to a project:

1.	 On the start page, click a project to open the project detail view.

2.	 If you want to add the file into a specific folder in the project, in the Explorer side 
pane, select the folder.

3.	 Click Add File ().

4.	 Browse to find and select the file that you want to upload.

5.	 Click Open.

6.	 Alternatively: You can also drag and drop files from Windows Explorer to the Explorer 
side pane.

7.	 The file will be added to your project.

File Statuses

STATE DESCRIPTION


The file is synchronized between your computer and the server, and is up to 
date.


If a file exists on the server but not locally, or a new version is available from 
the server, it will have a download icon. Clicking the icon will download the 
latest version of the file to your computer.


If the file only exists locally, it will be shown with an upload icon. Clicking the 
icon will upload the file to the server.


If the file has been deleted from the server but still exists locally, it is shown 
with a file removed icon. Clicking the icon will remove it from your computer.
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File Interactions & Controls 
Double clicking a file has different behaviors based on the file type & status:

•	 Double clicking a file will download the file from the server if it hasn't been 
downloaded yet.

•	 If the file is a model readable in Trimble Connect for Windows, it will open the 
context menu (double tap opens the file in the 3D Viewer. 

•	 If it is a 2D file, it will be opened with the associated default software.

File Controls
Once a file has been added, you will have access to different controls accessed through the 
context menu when right-clicking a file.

OPTION DESCRIPTION

Rename File Opens the Rename file dialog. 

The Invalid Name Warning will show if you try to rename a file with 
the same name as another file or if the name contains a special 
character listed under "File & Folder Naming Conventions" on page 
45.

Create Folder This option will create a folder at the same level as the selected file.

Add File This option will open the Windows Explorer Window and allows you 
to add files at the same level as the selected file.
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OPTION DESCRIPTION

Remove File When removing a file, a dialog will ask you if you want to remove the 
file locally or remove from a project completely. 

If a file does not exist locally, you can still remove it from the project.

Remove Local File: the file will be removed from your computer, but 
it will still be available from the server. The file will still be shown in 
the File Explorer as available for download (). 

Remove File from Project: When choosing to remove from the 
project, the file is removed locally and from the server.

Note: Removed files can be restored by a Project Admin. For more 
information, see the Trimble Connect for Browser User Guide 

Revision History This option opens the file's revision history. This allows you to see 
who and when the different versions of this file have been uploaded 
to the project. 

https://drive.google.com/file/d/15OzgnJ29b0PCXyXL9xyZpMIBBuGHMBOm/view?usp=sharing
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OPTION DESCRIPTION

Edit Tags This option opens the Edit tags dialog. This allows you to create or 
remove tags associated with the file. 

Tags can be added by simply clicking in the type field, writing the tag 
and pressing ENTER. Once a tag has been created, it can be reused 
across the whole project, for other files, or in ToDos.  

Clicking Remove () on the right side of the tag will remove the tag 
after saving the changes. 

Note: Once a tag has been created it cannot be removed from the 
project.

Add Folders
You can create folders to organize the files and models within a project.

1.	 On the start page, click a project to open the project detail view.

2.	 If you want to add the new folder under a specific folder in the project, in the 
Explorer side pane, select the folder.

3.	 Click Add folder ()

4.	 Users can give a name to the folder and create it. Folders are called New folder by 
default if the user doesn’t change the name.
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5.	 Click Create folder.

6.	 The folder is added to the open project.

To control who in the project can access a folder, you can set folder permissions to users or 
user groups. For more information, see the Trimble Connect for Browser User Guide .

Folder Controls
Once a folder has been created, you will have access to different controls accessed through 
the context menu when right-clicking a folder.

OPTION DESCRIPTION

Create Folder Create folder creates a new folder nested inside a selected folder. 
This can also be done by selecting a folder and clicking Add folder 
().

Rename Folder Opens the Rename folder dialog.

Add File Opens the Windows File Explorer dialog so you can add files to the 
folder. This can also be done by selecting a folder and clicking Add 
File ().

https://drive.google.com/file/d/15OzgnJ29b0PCXyXL9xyZpMIBBuGHMBOm/view?usp=sharing
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OPTION DESCRIPTION

Remove Folder When removing a folder, a dialog will ask you if you want to remove 
the folder locally or from a project completely. 

Remove Locally: the folder and its contents will be removed from 
your computer, but it will still be available from the server. The folder 
and its contents will still be shown in the File Explorer as available for 
download. 

Remove from Project: When choosing to remove from the project, 
the folder and its contents are removed locally and from the server.

Note: Removed files and folders can be restored by a Project Admin. 

See Trimble Connect for Browser User Guide  for more 
information

Download models All models a folder contains can be downloaded at once by clicking 
Download models. This is especially useful when a folder contains a 
large amount of models.

Managing Folder Permissions
With folder permissions, visibility of folders can be restricted based on user groups, 
individual users or can be specified as a default setting to be applied to all users in the 
project. Folder permissions are managed in the Trimble Connect for Browser application. 
This is a function only available to Project Admins. 

If you have limited access rights to a particular folder, buttons in that folder are grayed out, 
and dragging and dropping does not work.

For more information, see the Trimble Connect for Browser User Guide .

File Versions & Revision History

Add a New File Version
When trying to add a file that already exists in the project a dialog will open, asking if you 
want to replace the file or keep the original. When you click OK the file will be added as a 
new revision. Previous file revisions can be accessed through the File Revision History dialog.  

https://drive.google.com/file/d/15OzgnJ29b0PCXyXL9xyZpMIBBuGHMBOm/view?usp=sharing
https://drive.google.com/file/d/15OzgnJ29b0PCXyXL9xyZpMIBBuGHMBOm/view?usp=sharing
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Download a New Revision

Download Revisions from the Explorer Pane
When there is a new revision of a model file available on the server, you can download it by 
clicking the download file () icon in the Data Tab. If you click the View button while the file 
is still downloading, you will be taken into the 3D View where the file will be loaded once the 
downloading progress is complete.

Download Revisions from the 3D View › Models Tab
If the user is in 3D Viewer and a new revision of model has been added to the project, 
the Models Tab will show the file with a download icon (), indicating that there is a 
new version available. The new version of the file will not be downloaded until the user 
explicitly downloads the file. 

View File Revision History
1.	 On the start page, click a project to open the project detail view.

2.	 In the Explorer side pane, right-click the file whose revision history you want to view.

3.	 Select Revision history...

4.	 In the Revision history dialog box, view the revisions made to the file.



﻿Trimble Connect for Windows  ›  Files & Folders  53

Viewing Previous File Versions in 3D
1.	 Open a file in Trimble Connect for Window's 3D Viewer.

2.	 To open the Model Details Tab, double click on the model listed in the Models Tab, 
or click the model details icon ().

3.	 The currently loaded version is shown in the Model Details Tab.

4.	 Click Select version...

5.	 The Revision History dialog will open.

6.	 Double click on the desired version you want to view.

7.	 The file will be downloaded and then loaded in the 3D View.
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Upload Files & Folders 
All data that exists locally in the project can be uploaded by clicking Upload all files to the 
server (). 

1.	 On the start page, click a project to open the project detail view

2.	 In the Explorer side pane, click Upload all files to the server ().

3.	 Once the upload is complete, the files and folders will be available in any of the 
Trimble Connect applications. 

Alternatively, you can upload all files within a folder to the server. To do so, right-click the 
folder and select Upload files.

Download Files & Folders
All project files and folders existing on the server can be downloaded by clicking Download 
all files from server (). 

1.	 On the start page, click a project to open the project detail view.

2.	 In the Explorer side pane, click Download all files from server ().

Canceling an Upload or Download Operation
When the download or upload process has started, a synchronization icon replaces the file 
icon (). To cancel, click .

If uploads or downloads are in progress, and you decide to close Trimble Connect for 
Windows, a dialog will open indicating synchronization is still in progress. If you decide to 
exit, all upload or download operations will be canceled.
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Comment on Files & Folders
It is possible to comment on files or folders, by hovering over the file or folder and clicking 
the Comment () icon that appears next to it. Comments are visible for all users in the 
project.

Clicking the icon will open the Create Comment dialog, from which a comment can be 
added. Comment and comment attachments will be accessible from the Model Details Tab 
in the 3D Viewer.  

Once at least one comment has been created for a file, the number of comments can be 
seen in the File Explorer.

For more information on, see the Trimble Connect for Browser User Guide 

Move Files & Folders
Folders can also be dragged and dropped to be moved between other folders. Files can 
also be dragged and dropped to be moved between folders. Files or folders can’t be drag & 
dropped on the same folder containing items with the same name. 

1.	 On the start page, click a project to open the project detail view.

2.	 In the Explorer side pane, drag and drop the file or folder to a new location.

https://drive.google.com/file/d/15OzgnJ29b0PCXyXL9xyZpMIBBuGHMBOm/view?usp=sharing
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Rename Files & Folders
1.	 On the start page, click a project to open the project detail view.

2.	 In the Explorer side pane, right-click the file or folder that you want to rename.

3.	 Select Rename file or Rename folder from the context menu.

4.	 Type a new name for the file or folder.

5.	 Click Rename.

Remove Files & Folders
1.	 On the start page, click a project to open the project detail view.

2.	 In the Explorer side pane, right-click the file or folder that you want to remove.

3.	 Select Remove file or Remove folder from the context menu..

4.	 Select if you want to remove the local file from your computer or remove the file 
from the project.

Viewing 2D Files
With Trimble Connect, you can view both 2D files and 3D models locally on your computer.

To view a 2D file, such as a photo, a document, or a PDF file:

1.	 On the start page, click a project to open the project detail view.

2.	 In the Explorer side pane, double-click the file.

3.	 The file will open in another application.
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View Files & Folders in 3D
Clicking the View button has different behaviors based on what is selected in the Data Tab.

To view a 3D file:

1.	 On the start page, click a project to open the project detail view.

2.	 In the Explorer side pane, double-tap on the file or select the file and click View.

3.	 The file will open in the 3D Viewer.

TO... DO THIS...

View the project in 3D To open the entire project folder structure in the 3D 
Viewer, click on the View button. Be sure there are no 
folders or files selected.

View all models in a folder If a folder is selected, clicking View will open the 3D 
Viewer with the folder and it's models listed in the 
Models Tab.

Note

The first time loading a model might be slow. After that, the files are loaded from the existing 
cache, which makes it faster. Loading progress is shown when the file is loading. Icon tooltip 
gives additional information about loading progress.

If a corrupted model is added to the project, Trimble Connect for Windows will still try to 
load it into 3D view. When reading the model fails, it can’t be loaded and it appears as red in 
the Models Tab.
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Working in 3D

Reference Guide
You can perform several different tasks while working in the 3D Viewer. Below is a reference 
guide which shows the icons used in the 3D View and which page you can go to learn more 
about it.

ICON NAME CROSS REFERENCE

 Exit 3D View --

 Single Object/Part Sector "Select Single Objects" on page 71

 Area Selector "Making Selections" on page 70

 Assembly Selector "Making Selections" on page 70

 Hide Selection "Visibility Tools" on page 73

 Hide Others "Visibility Tools" on page 73

 Show Only "Visibility Tools" on page 73

 Show All "Visibility Tools" on page 73
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ICON NAME CROSS REFERENCE

 Fit to View "Adjust the 3D View" on page 76

 Reset Model "Adjust the 3D View" on page 76

 Model Views "Adjust the 3D View" on page 76

 Distance Measure "Distance Measure" on page 59 


Vertical/Horizontal Shortest 
Distance Measure

"Vertical or Horizontal Distance 
Measurements" on page 84 

 Markup "Markups" on page 86

 Color Selector "Coloring Measurements & Markups" on 
page 92

 Clip Plane "Clip Planes" on page 93

 Add ToDo "Working in 3D: ToDos" on page 124

 Undo --

 Redo --

Model Transparency "Visibility Tools" on page 73

 Ghost Mode "Visibility Tools" on page 73

 Orthogonal / Perspective View "Adjust the 3D View" on page 76
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ICON NAME CROSS REFERENCE

 Show or Hide Clashes
"Visibility Tools" on page 73

"Working in 3D: Clashes" on page 138

 Show/Hide Object Attachments
"Visibility Tools" on page 73

"Object Attachments" on page 119

 Show/Hide Grids "Model Grids Updated" on page 107

 Grid Selector "Model Grids Updated" on page 107

 Rotate Camera "Rotate the Model" on page 66

 Pan Camera "Pan the Model" on page 67

 Walk Around Camera "Walk Around the Model" on page 68

 Look Around Camera "Look Around the Model" on page 69

 Enter/Exit Fullscreen Mode "Adjust the 3D View" on page 76

Navigation Wheel "Navigation & Controls" on page 64

Zoom In/Out "Adjust the 3D View" on page 76

 Open/Close Tabs --

 Models Tab "Working in 3D: Models" on page 98
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ICON NAME CROSS REFERENCE

 Objects Tab "Working in 3D: Objects" on page 111

 ToDos Tab "Working in 3D: ToDos" on page 124

 Clashes Tab "Working in 3D: Clashes" on page 138

 Views Tab "Working in 3D: Views" on page 151

 Sequence Tab "Working in 3D: Sequences" on page 163

 Point Cloud Tab "Working in 3D: Point Clouds" on page 
170

Keyboard Shortcuts

General Shortcuts

RESULT SHORTCUT

Undo last action. CTRL + Z

Redo last action. CTRL + Y

End an operation ESC

Open the context menu Right clicking an object opens its context menu.
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Camera Shortcuts

RESULT SHORTCUT

Fit to view selected objects. SPACEBAR

Fit to View Double clicking an object fits the object to view, and 
highlights it in the Objects Tab.

Orthogonal mode for a surface ALT + double click a surface

Switch to Rotate around mode. CTRL + U

Switch to Pan mode. CTRL + I

Switch to Walk around mode. CTRL + O

Switch to Look around mode. CTRL + P

Switch between normal/ 
fullscreen.

F11
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Selection Shortcuts

RESULT SHORTCUT

Add to Selection Hold down CTRL and select objects and add them to 
the selection.

Add/Remove from Selection Hold down SHIFT and select objects Adds/Removes 
them from the selection.

Hide others. SHIFT + BACKSPACE

Hide selected. BACKSPACE

Open Detail Tab Select and object and press ENTER opens its details 
tab.

Remove from Selection Hold down CTRL + SHIFT and select objects removes 
them from the selection.

Reverse the selection mode. Hold ALT while selecting objects/assemblies

Unselect all objects. ESC

Views Shortcuts

RESULT SHORTCUT

Creates a new view. CTRL + N

Loads the previous view. CTRL + Q

Loads the next view. CTRL + W
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Working in 3D: Navigation & Tools

Navigation & Controls
Navigating the model in the 3D Viewer is done through the mouse or trackpad. The default 
camera and navigation mode is Rotate mode.

The top toolbar above the navigation wheel allows you to change 
the navigation mode, and also to switch to fullscreen (most right 
button). The active navigation mode is highlighted in blue in the 
top toolbar, and also shown in the middle of the wheel.

The navigation can also be done through the navigation wheel. 
Arrows have the same behavior as pressing the arrow keys on 
the keyboard. The zooming can be done by clicking the + and - 
buttons, or drag the slider up and down.
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Navigation Wheel

TOOL BEHAVIOR

Shows the active Camera/Navigation Mode. 

To show or hide the Navigation Mode Toolbar clicking the center of the wheel.

     

The 3D Viewer has four navigation modes:

1.	 Rotate ()

2.	 Pan ()

3.	 Walk Around () 

4.	 Look Around ()

 Tilts the camera upwards

 Turns the camera to the right

 Tilts the camera downwards

 Turns the camera to the left



﻿Trimble Connect for Windows  ›  Working in 3D: Navigation & Tools 66

Rotate the Model
1.	 If the Navigation Toolbar is hidden, click the middle of the Navigation Wheel.

2.	 The Navigation Toolbar will appear above the Navigation Wheel.

     

3.	 If it is not already selected on the toolbar, select Rotate ().

4.	 Pick a point in the model and hold down the left mouse button.

5.	 Move the mouse as needed to rotate the model around the point you picked.

Mouse Behaviors

MOUSE CLICK/INTERACTION BEHAVIOR

Arrow keys/Left mouse drag Rotate around point

Middle mouse button drag Pan

Right mouse button drag Rotate in position

Scroll mouse Zoom in/out

Hold down left mouse button (0.5sec) Area selection
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Pan the Model
1.	 If the Navigation Toolbar is hidden, click the middle of the Navigation Wheel.

2.	 The Navigation Toolbar will appear above the Navigation Wheel.

    

3.	 On the toolbar, select Pan ().

4.	 Pick a point in the model and hold down the left mouse button.

5.	 Move the mouse to move the model.

Mouse Behaviors

MOUSE CLICK/INTERACTION BEHAVIOR

Arrow keys/Left mouse drag Pan

Middle mouse button drag Pan

Right mouse button drag Rotate in position

Scroll mouse Zoom in/out

Hold down left mouse button (0.5sec) Area selection
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Walk Around the Model
1.	 If the Navigation Toolbar is hidden, click the middle of the Navigation Wheel.

2.	 The Navigation Toolbar will appear above the Navigation Wheel.

    

3.	 On the toolbar, select Walk ().

4.	 Pick a point in the model and hold down the left mouse button.

5.	 Move the mouse to the walking direction.

Mouse Behaviors

MOUSE CLICK/INTERACTION BEHAVIOR

Arrow keys/Left mouse drag Zoom and rotate in position

Middle mouse button drag Pan

Right mouse button drag Rotate in position

Scroll mouse Zoom in/out

Hold down left mouse button (0.5sec) Area selection
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Look Around the Model
1.	 If the Navigation Toolbar is hidden, click the middle of the Navigation Wheel.

2.	 The Navigation Toolbar will appear above the Navigation Wheel.

    

3.	 On the toolbar, select Turn Head ().

4.	 Pick a point in the model and hold down the left mouse button.

5.	 Move the mouse to the walking direction.

Mouse Behaviors

MOUSE CLICK/INTERACTION BEHAVIOR

Arrow keys/Left mouse drag Zoom and rotate in position

Middle mouse button drag Pan

Right mouse button drag Rotate in position

Scroll mouse Zoom in/out

Hold down left mouse button (0.5sec) Area selection
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Making Selections

There are several modes that you can use to select objects in 3D. These are: 

•	 Single Selection Mode

•	 Area Selection Mode

•	 Assembly Selection Mode

The default selection mode is Single Selection Mode. This mode is on by default and cannot 
be explicitly disabled. 

TOOL BEHAVIOR

  
Single Selection Mode. This is the default selection mode. Objects 
can be picked in 3D view.

When activating one of the following tools, the default mode is 
disabled: 

•	 Area selection
•	 Measurements
•	 Markups
•	 Clip planes
•	 Model relocation tools
•	 Point picker via the API

When some tool is deactivated explicitly (by pressing the button or 
pressing ESC or pressing close in model relocation tools), the default 
picking mode is automatically activated.

   
Area Selection Mode. This does exactly the same as holding the left 
mouse button for 0.5 seconds and dragging and dropping the cursor.

   
Single Assembly Selection Mode enabled.

When Assembly Selection is enabled, selection is applied to highest 
level assemblies or systems if applicable. If the object does not 
belong to either one, the single object is selected instead.

     Area Assembly Selection Mode enabled.
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Select Single Objects
1.	 Ensure that Single Selection Mode () is selected on the toolbar, or select it.

2.	 Click an object in the model to select it.

a.	 If you want to select multiple objects separately, hold down SHIFT and pick 
the objects.

b.	 If you want to remove single objects from your selection, hold down CTRL 
and pick the objects.

Select All Objects in a Particular Area
1.	 On the toolbar, select Area Selection ().

2.	 To select the objects entirely within the area

a.	 Hold down the left mouse button.

b.	 Drag the mouse from left to right to create a rectangle around the desired 
area.

c.	 Release the left mouse button.

3.	 To select the objects entirely and partly within the area

a.	 Pick a point in the model, and hold down the left mouse button.

b.	 Drag the mouse from right to left to create a rectangle around the desired 
area.

c.	 Release the left mouse button.

Assembly Selection Mode
When the Assembly Selection Mode is activated, selecting an object automatically selects the 
assembly that the object belongs to. Note that this only applies if the object belongs to an 
assembly. Otherwise, the object itself is selected.

Modifier key Alt reverses the selection mode. The selection mode setting is remembered 
between user sessions. The Objects Tab content is also filtered based on the selection mode. 

•	 When Assembly Selection Mode is enabled, the content is filtered to show only 
assemblies/systems and/or objects if they do not belong to either one. 

•	 When Object Selection Mode is enabled, both assemblies and single objects they 
contain are shown in the objects list.
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To select single assemblies

1.	 Ensure that Single Selection Mode () is selected on the toolbar, or select it.

2.	 On the toolbar, enable Assembly Selection Mode ().

3.	 Select an object in the model.

4.	 If there is an assembly present in the model, it will be selected, otherwise the part 
will be selected.

To select all assemblies in an area

1.	 Ensure that Area Selection () is selected on the toolbar, or select it.

2.	 On the toolbar, enable Assembly Selection Mode ().

3.	 Hold down the left mouse button.

4.	 Drag the mouse from left to right to create a rectangle around the desired area.

5.	 Release the left mouse button.

6.	 If there is an assembly present in the model, it will be selected, otherwise the part 
will be selected.
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Visibility Tools
In the upper left corner of the 3D view can be found the visibility tools, which allows you to 
control objects and models visibility.

TOOL DESCRIPTION

 Hide Selected
Hide the selected objects.

 Hide Others
Hide all but selected objects.

 Show Only
Show only the selected objects.

 Show All
Show all objects in the project.

Transparency slider
Allows to change the transparency for all objects in the project.

 Ghost Mode
In ghost mode, hidden objects are shown with high transparency and 
cannot be selected.

 Toggle on/off clash flags.
See "Clashes in 3D" on page 149 for details.
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TOOL DESCRIPTION

 Toggle on/off files/ToDos link icons.
See "Object Attachments" on page 119 for details.

 Toggle on/off model grids.
See "Model Grids Updated" on page 107 for details.

 Grid Selection
To select the grids that you want to show, click the arrow () below 
, and select the checkbox next to the grids that you want to show.

See "Model Grids Updated" on page 107 for details.

Hide a Selection
If you want to hide a selection: 

1.	 Select the objects that you want to hide.

2.	 On the toolbar, click Hide Selected ().

3.	 Your selection will be hidden.

4.	 You can revert by selecting Show All ().
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Show Only the Selected Objects
If you want to show only the selected objects: 

1.	 Select the objects that you want to show only.

2.	 On the toolbar, click Show Only ().

3.	 All other objects and models will be hidden.

4.	 You can revert by selecting Show All ().

Using Ghost Mode
Ghost mode is great when you are trying to give context to the visible objects. 

1.	 To start, select some objects and use either Hide Selected () or Show Only () to 
have some objects visible and others hidden.

 

2.	 Turn on Ghost Mode () located in the Visibility Toolbar. 

3.	 The hidden objects will be shown with a high transparency but cannot be selected. 
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Adjust the 3D View
When you are working in Trimble Connect for Windows, you can adjust how 3D models are 
shown. You can either fit models or objects to the 3D View, change the perspective of the 3D 
View, or reset all selections, markups, clip planes and measurements in the 3D View.

TOOL BEHAVIOR

 Fit to view. Fit to view the selected objects.

 Reset model. Reset all object colors and visibility, and set the camera back to 
Axon view.

 Model Views. Set the predefined view to be shown in 3D view. The different 
predefined Views available are the following ones: 

 Default (Axon) view

 Top view

 Front view

 Left view

 Back view

 Right view

 Bottom view



﻿Trimble Connect for Windows  ›  Working in 3D: Navigation & Tools 77

TOOL BEHAVIOR

 Switch between perspective/orthogonal mode. 

•	 In perspective distant objects appear smaller than close ones. 

•	 In orthogonal, the object's size is retained independently of the 
distance to the view point. You cannot navigate through objects in the 
orthogonal mode.

 Toggle full screen mode

Zoom In

Zoom slider. Drag the slider to zoom in or out of the model view

Zoom Out

Switch to Fullscreen Mode
1.	 If the Navigation Toolbar is hidden, click the middle of the Navigation Wheel.

2.	 The Navigation Toolbar will appear above the Navigation Wheel.

    

3.	 On the toolbar, select Fullscreen Mode ().

4.	 To exit full screen mode, click Fullscreen Mode () again.

Fit Models or Objects to the 3D View
If you want to fit the view to particular objects, in the 3D View:

1.	 Select the objects that you want to zoom to.

2.	 On the toolbar, select Fit to View ().
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Change the Model Perspective
1.	 On the toolbar, open the Model Views () menu

2.	 In the list, select a View angle:

a.	  Default (Axon) view

b.	  Top view

c.	  Front view

d.	  Left view

e.	  Back view

f.	  Right view

g.	  Bottom view

Reset the 3D View
To reset all selections, object colors, visibility, markups, clip planes and measurements:

1.	 On the toolbar, click Reset Model ().

2.	 The model will be reset to its original state.
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Working in 3D: Markups, 
Measurements & Clip Planes
Trimble Connect for Windows provides several markups that can be used in 3D and saved as 
Views in order to add useful information. 

 

Snapping
Snapping in 3D indicates which point, edge or surface is going to be picked.

The available snap points are dependent on which tool (Measurement, Markup or Clip Plane) 
you are using.

CORNER SNAPPING EDGE SNAPPING FACE SNAPPING

Measuring Distances
You can use the measuring commands in Trimble Connect for Windows to measure 
distances between points in the 3D View. You can measure the distance between two points, 
or the shortest vertical or horizontal distance from a point, face, or edge to another object.
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Measurement's unit and precision is defined from the Project Settings Dialog. Please see 
"Project Settings" on page 34 for more detailed information.

At measurement creation, the set unit and precision will be used. Measurements are not 
updated when changing the unit settings, which means that measurement with different 
units and/or precision can be saved in the same view.

Visualizations

Perpendicular Measurements Perpendicular measurements can be identified by the 
right angle indicator shown at the start or endpoint of a 
measurement.
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Point to Point

Arrows point to the corner points that the start and 
endpoint was snapped to. 

Point to Face

A square is drawn on the object to indicate the face which 
the endpoint was snapped to. 

Point to Line

A line will be drawn on the object to indicate the line 
which the endpoint was snapped to.



﻿Trimble Connect for Windows  ›  Working in 3D: Markups, Measurements & Clip Planes 82

Line to Line

Line to Face

Face to Face

Create a Distance Measurement 
1.	 On the toolbar, click Distance Measure ().

2.	 Pick the point, edge or face from which you want to start measuring.

3.	 Pick the point, edge or face of the object from to which you want to measure.

4.	 A label appears, showing the measurement between the selected points.
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Exit the Distance Measurement Mode
Measurement mode is continuous. It will stay active even after a measurement is placed. As 
long as the tool is active, the measurement button is highlighted in blue. 

To exit measurement mode:

•	 Press the Escape key (ESC).

•	 Click Distance Measure () again to deactivate the tool.

Removing Distance Measurements

Remove a Single Measurement
Measurements can also be removed one by one by selecting them and: 

•	 Pressing the DELETE key 

•	 Use the right click context menu and click Remove.

Remove All Measurements
If no measurements have been created yet, the measurement removal tool is disabled 
(grayed out), but it is enabled as soon as a measurement is created. Clicking Clear All 
Normal Measurements () will remove all measurements from the 3D View.
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Vertical or Horizontal Distance Measurements
The Horizontal/Vertical measurements tool allows you to create an horizontal or vertical 
measurement between two objects. 

To create a horizontal or vertical measurement, the user needs to activate the tool from the 
toolbar. 

Once the tool is active you will first pick a point, edge or face of an object. For the second 
point, users can only pick objects perpendicular to the first picked point. 

The measurement created will then represent the shortest distance between the point, edge 
or surface, and the picked object. Distance measurements are shown red, horizontal or 
vertical measurements are blue.

Horizontal or Vertical measurement units and precision are defined from the same Project 
Settings dialog as other measurements. Please see "Project Settings" on page 34 for 
more detailed information.

Measure the Shortest Vertical or Horizontal Distance
1.	 On the toolbar, click Vertical or Horizontal Shortest Distance ()

2.	 Pick a point, face, or edge from which you want to start measuring.

3.	 Pick an object perpendicular to the first point that you want to measure.
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A dotted blue line will appear when you are hovering over an object that is 
perpendicular to your first picked point.

4.	 Select the object. A label will appear, showing the measurement between the 
selected point and the object.

Exit the Measurement Mode
Measurement mode is continuous. It will stay active even after a measurement is placed. As 
long as the tool is active, the measurement button is highlighted in blue. 

To Exit Vertical or Horizontal Shortest Distance Measurement Mode:

•	 Press the Escape key (ESC).

•	 Click Vertical or Horizontal Shortest Distance () again to deactivate the tool.

Removing Vertical or Horizontal Distance Measurements

Remove a Single Measurement
Measurements can also be removed one by one by selecting them and: 

•	 Pressing the DELETE key 

•	 Use the right click context menu and click Remove.

Remove All Measurements
If no measurements have been created yet, the measurement removal tool is disabled 
(grayed out), but it is enabled as soon as a measurement is created. Clicking Clear All 
Vertical or Horizontal Measurements () will remove all measurements from the 3D 
View.
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Markups

Use markups to highlight objects and parts in the 3D View. You can also add text to 
comment on the model. Markups will be saved locally.

There are 5 types of markup available:

•	 Freehand Markups () are markups that you can draw by hand.

•	 Line Markups () draw a line between two points that you pick.

•	 Arrow Markups () draw an arrow between two points that you pick.

•	 Text Markups () allow you to type text in the model.

•	 Cloud Markups () draw a cloud in the model.

To switch between markups, use the arrow next to the Freehand markup.
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Freehand Markups
Freehand markups are used to draw on object surfaces to add information to a View. By 
default, the markup dropdown shows that tool. Create a View to share the markup with 
others.

•	 The placement of the freehand markup cannot be edited after creation. 

•	 Freehand markup color can be changed after creation.

•	 Freehand markup selected state is blue. 

Add a Freehand Markup

1.	 On the toolbar, click Freehand Markup ().

2.	 Pick the point where you want to place the markup and hold down the left mouse 
button.

3.	 Drag the mouse to draw the markup.

4.	 Release the left mouse button.
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Line Markups
Line markups are used to draw lines on object surfaces to add information to a View. Create 
a View to share the markup with others.

•	 The placement of the line markup cannot be edited after creation. 

•	 Line markup color can be changed after creation.

•	 Line markup selected state is blue.

Add a Line Markup

1.	 On the toolbar, open the Markup Menu by clicking Select Markup Tool () next to 
the Freehand Markup () tool.

2.	 Activate the Line Markup () tool.

3.	 Pick the start point of the line by picking an object face, edge, or corner.

4.	 Pick the end point of the line by picking an object face, edge, or corner.
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Arrow Markups
Arrow markups are used to draw pointers on object surfaces to add information to a View. 
Create a View to share the markup with others. 

•	 The placement of the arrow markup cannot be edited after creation. 

•	 Arrow markup color can be changed after creation.

•	 Arrow markup selected state is blue. 

•	 The First point defines where the arrow is going to point to.

Add an Arrow Markup

1.	 On the toolbar, open the Markup Menu by clicking Select Markup Tool () next to 
the Freehand Markup () tool.

2.	 Activate the Arrow Markup () tool.

3.	 Pick the start point of the arrow by picking an object face.

4.	 Pick the end point of the arrow.
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Text markup
Text markups are used to write on object surfaces to add information to a View. 

•	 The text cannot be edited after creation. 
•	 The placement of the text box can be moved after creation, but the location of the 

arrow cannot be changed after creation.
•	 Text markup color can be changed after creation.
•	 The text will be moved, and an arrow indicates where the text was first created.

Add a Text Markup

1.	 On the toolbar, open the Markup Menu by clicking Select Markup Tool () next to 
the Freehand Markup () tool.

2.	 Activate the Text Markup () tool.

3.	 Pick the point where you want to add the text markup.

4.	 Type the desired text in the text box.

5.	 To save the text markup, press Enter on the keyboard.

6.	 Press the ESC key and exit the Markup mode.

7.	 To move the text, select the markup, and drag and drop it somewhere else.

8.	 An arrow points to the area where the markup was first created.
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Cloud Markups
Cloud markups are used to draw on object surfaces to add information to a View.

•	 Cloud markup can be edited after creation. 
•	 Cloud markup selected state is blue. 
•	 Using a mouse wheel or track pad scales the markup. 
•	 Cloud markup can also be moved by drag and dropping it.

Add a Cloud Markup

1.	 On the toolbar, open the Markup Menu by clicking Select Markup Tool () next to 
the Freehand Markup () tool.

2.	 Activate the Cloud Markup () tool.

3.	 Pick the plane where you want to add the cloud markup.

4.	 If necessary, re-size the cloud markup by scrolling forward or backward with the 
middle mouse button.
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Removing Markups

Remove a Single Markup
Markups can also be removed one by one by selecting them and: 

•	 Pressing the DELETE key 

•	 Use the right click context menu and click Remove.

Remove All Markups
If no markup is created in the view, the markup removal tool is disabled (grayed out), but it 
is enabled as soon as a markup is created. Clicking Clear All Markups () will remove all 
measurements from the 3D View.

Coloring Measurements & Markups
Measurements and markups can be colored using one of the colors available in 
Trimble Connect for Windows. The different available colors are shown on the left. 
To create a measurement/markup with another color, simply choose the wanted 
color, and then create the measurement/markup.

The chosen color is then displayed in the toolbar to indicate what will be the color 
used from now on.

Users can also change the color of an already existing measurement/markup if 
they want, by selecting the measurement/markup and changing the color. Colors 
are saved in Views.
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Working with Clip Planes
Use clip planes to create cross-sectional Views of 3D models. You can create clip planes both 
vertically and horizontally. Once the desired cross section has been created, it can be saved 
as a View or a ToDo and shared with various team members.

Clip Planes
Clip planes are used to clip objects in the view and create for example section Views. 

•	 There can be up to 8 clip planes at the same time in the view.

•	 Clip planes can be placed along an object face or edge line.

•	 When creating a clip plane by snapping to an edge line, the clip plane is created in 
the plane perpendicular to it.

Add a Clip Plane

1.	 On the toolbar, click Add Clip Plane ().

2.	 Place the clip plane along the axis that you want to use to slice the model.

3.	 The clip plane icon () appears on the clip plane.
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Use Clip Planes to Create Elevation Measurements 

•	 Objects clipped points and edges can now be used as picking points and edges for 
measurement creation.

•	 When the clip plane is removed, the associated measurements are removed too.  
Other measurements existing in the view are untouched.

•	 Measurements cannot be created between clipped points or edges and non-clipped 
points, edges or surfaces.

Vertical Clip Planes
The Vertical Clip Plane tool can be used to force the direction of a clip plane to always be 
vertical. 

Add a Vertical Clip Plane

1.	 On the toolbar, open the Clip Plane Menu by clicking Select Clip Plan Tool () next 
to the Add Clip Plane () tool

2.	 Activate the Add Vertical Clip Plane () tool.

3.	 Place the clip plane along the axis that you want to use, to slice the model.

4.	 The clip plane icon () appears on the clip plane.
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Move a Clip Plane
1.	 Click the clip plane icon () on an existing clip plane.

2.	 The icon and clip plane edges will turn blue. 

3.	 Hold down the left mouse button and drag the clip plane to a new place.

4.	 When the clip plane is placed correctly, release the left mouse button.

Flip a Clip Plane
Clip planes can be now flipped to the opposite direction. Select a clip plane and then right 
click, the option to Flip is in the context menu.
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Clip on a Path
Advanced clip planes can be created by using wires as input. When creating a clip plane on 
a wire, it can then be moved along the wire. This feature works for both normal and vertical 
clip planes.

1.	 To start, select the wire (it will highlight in purple) that you want to clip along.

 

2.	 Isolate the wire by clicking Show Only () on the toolbar.

3.	 On the toolbar, activate the Clip plane tool ( or ) you want to use.

4.	 Place the clip plane on the wire.
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5.	 The clip plane icon () appears on the clip plane.

6.	 You can now move the clip plane along the wire.

 

Remove a Clip Plane
Clip planes can also be removed one by one by selecting them and: 

•	 Pressing the DELETE key 

•	 Use the right click context menu and click Remove.
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Working in 3D: Models
The Models Tab contains all models in the project that have been downloaded and can be 
read in Trimble Connect for Windows.

Manage Models
All readable models that have already been downloaded in the project can be shown in the 
Models Tab. 

Local model files can also be directly added to the 3D view by using the Add model () 
button in Model Selection dialog. Please see the next section for details.

If a model has been updated on the server side, an update icon () will appear next to that 
model in the Models Tab. Clicking the update icon () will download the new version of the 
model and load it into the 3D view automatically.

The new version of the file will not be downloaded until the user explicitly downloads the 
file. 

When selecting a model from the Models Tab, it also gets selected in 3D. However, hovering 
over a model will not highlight it in 3D view, so that browsing the Models Tab remains 
smooth.
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Add Models to the 3D Viewer
Models can be loaded by clicking the model selection button, which opens the model 
selection dialog, where the entire project hierarchy can be found.

To Load More Models

1.	 Click the Model Selection button.

2.	 The Model Selection dialog will open.

3.	 Click the checkbox next to the model or folder you want to add.

4.	 The selection will be added to the Models Tab.

5.	 Click Close to complete the operation.

ICON DESCRIPTION

 Expand or Collapse Folder Structure

The list can be expanded/collapsed using the Expand/Collapse all folders 
button. 

 Add File

Users can also add local files from that dialog.
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Remove or Unload Models 
Model loading can be managed from Models Tab through by right clicking a model or model 
group to open the context menu and selecting Unload. Unloaded models are still shown in 
the Models Tab, but their color indicator is removed, and their visibility indicator is set as 
hidden.

Models can also be unloaded by using the Model Selection Dialog. To do so, click the Model 
selection button, which opens the Model Selection Dialog. When un-checking models in this 
dialog, they will be removed from the Models Tab immediately.

Model & Folder Visibility 
Model visibility and colors can be changed from the Models Tab. Changes are applied to all 
objects the model contains.

ICON DESCRIPTION

 Visible

The Models or folders can be hidden/shown by clicking the visibility icon. 
Changing the visibility has no effect on model loading if the model is already 
loaded in 3D (hidden models are still loaded in 3D view).

 Partial Visibility

When a model folder, a model or an assembly contains both hidden and 
shown objects, the visibility symbol looks like this.

 Hidden

When a model folder, or a model is hidden, the visibility symbol looks like this.
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Change the Model Color
Model color and transparency can be changed using the color icon (  ). If the model 
contains objects of different colors, the multicolor icon is used. If all objects in the model 
have the same color, the color indicator will use that color. The transparency is always 0% by 
default.

Color and transparency are set from the Color Customization dialog, which opens when 
clicking the color icon (  ).

Once color and transparency have been changed, they are reflected by the color indicator. 
The entire model color and transparency will be updated accordingly.

If the model color or transparency has been changed from the default, an asterisk (*) is 
placed above the color icon to indicate a custom setting has been applied. 
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Model Details
The Model Details Tab opens when double clicking a model, or by clicking the model details 
icon ().

The Model Details Tab contains:
•	 Model Information
•	 Version
•	 Model Position
•	 Comments
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Model Versions
The currently loaded version is shown in the model details tab. To load a previous version 
click the Select version button.

This opens the revision history for the model, from which the currently used version of the 
file in the project can be switched as needed, by double clicking a version in the list. 

Model Positioning 
Model positioning can be changed from the from the Model Details Tab. You have several 
options to reposition a model:

•	 Models can be re-positioned by entering directly X,Y and Z positions/rotations. 

•	 Models can be re-positioned by using the three commands (Move, Rotate and Align) 
found in the bottom of the Model Details Tab.
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OPTION DESCRIPTION

Position X or Y Models can be relocated by entering directly X and Y positions.

Elevation Models can be relocated by changing their elevation.

Scale Models can also be scaled using the scale field. Scale is always set 
to 100 by default. The scale is just a visual factor, and doesn’t affect 
the object properties in any way.

Rotation X, Y or Z Models can be relocated by entering directly X,Y and Z rotation.

Move
Move the model by picking points in the 3D view. User needs to 
pick a start and end point.

Rotate
Rotation axis (X, Y or Z) needs to be picked first. Rotate the model 
by picking points in the 3D view. User needs to pick two points 
to define the reference line, and pick a third point to define the 
rotation.

Align
Align the model with another model by picking points in the 3D 
view. User needs to pick the start and end point for the first line, 
and then for the second line. The angle formed between the two 
lines is the rotation angle.

Reset Placement
Model location and scale can be reset back to the origin (and scaled 
back to 100) by clicking the Reset Placement button.
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Model Groups
The model listed in the Models Tab follows the project hierarchy created in the Data Tab. All 
models are found under a main group (root folder), which has the project name. All folders 
in the project are also represented in the Models Tab as Model Groups.

Users cannot create new model groups from the Models Tab That being said, every change 
done from the Data Tab is reflected right away in the Models Tab (folder hierarchy and 
name, files location and name, etc...).

Model Hierarchy 
When a model contains a hierarchy, an arrow will be shown before the visibility control so 
you can expand or collapse the hierarchy.

Model objects' visibility and color can be customized from any level of a hierarchy the same 
way you can for the model itself, by using the Visibility () and Color (  ) icons.

Hierarchy support is provided for IFC, Sketchup and LandXML files.
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Search the Models Tab
The Models Tab can be searched by using Search (), located in the upper right corner.

When clicking Search (), text can be entered. Pressing ENTER validates the entry, and the 
Models Tab turns into a flat list, displaying only the model groups/models corresponding to 
the applied filters.

Existing tags are also available in the search dropdown to be picked. List is also filtered 
accordingly. Combination of texts and tags can be used to cross filter the list and display only 
the model groups/models matching all search entries.

The icon in front of the currently active entries indicates if it is a text (), user () or a tag 
(), as seen above. Clicking the Remove button on the end of the entry clears it. Clicking the 
Remove button on the right side of the filter field clears all entries, and the File Explorer goes 
back to normal state.

When typing a new search, previously used text is proposed, so that they can be reused for 
subsequent searches.

Double clicking a model after filtering the Models Tab opens that model property tab. 
Double clicking a model group turns the Models Tab back to normal display with the related 
group open.

Export as TrimBIM
TrimBIM (.trb) is Trimble's proprietary 3D model file format.

You can now export a View as 3D .trb model: 

1.	 Adjust the 3D View according to your needs.

2.	 On the left side pane, click to open the Models list.

3.	 Click Export as trb ( ) at the top of the Models list.

4.	 Browse to the location where you want to save the TrimBIM model.

5.	 Name the TrimBIM model.

6.	 Click Save.
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Model Grids Updated 
Grids can be contained in ifc models, or can be a model by themselves. They are slightly 
different than other models and Trimble Connect for Windows provides controls specifically 
for grids.

Context Menu Functions
On top of all other features provided for all models, grids also have special controls, 
available through the context menu. 

OPTION DESCRIPTION

Zoom Here Zoom here zooms the 3D view towards the grid. 

Go To Go to is only available in perspective mode. This zooms towards 
the grid and changes the camera angle so that the appearance is 
the same as standing next to the grid.

Plane View Plane view turns the camera orthogonally to the grid and fits it to 
view. 

ALT + double clicking the grid has the same effect.
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Zoom In on A Grid Line New 
1.	 Move the pointer over a point where you want to zoom in on a grid line.

The grid line is highlighted.

2.	 Right-click and select Zoom here.

Go To a Grid Line New 
You can use the Go to command to go to the selected point on the grid line and align the 
view parallel to the grid plane. The command is not available in orthogonal mode.

1.	 Move the pointer over a point where you want to go to.

The grid line is highlighted.

2.	 Right-click and select Go to.

You can use the Go to command to go to a grid intersection.

Turn a View Perpendicular to a Grid Plane New 
Right-click the grid and select Plane view from the context menu.
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Grid Visibility
When adding a grid or a model containing a grid to the project, the grid button is shown next 
to the model in the Models Tab. That button allows to enable/disabled the grid in the 3D 
view.

•	 If the grid is a full model, the only control available in the Models Tab is the grid 
visibility button.

•	 Otherwise, all controls are available on top of grid controls for models also 
containing objects.

•	 The model group containing the grid also allows to control visibility for all grids in the 
group.

•	 Clicking the grid visibility button hide enables/disables the grid in the 3D view. Grids 
are enabled by default when adding a grid model into the project.

•	  Grid visibility enabled. Clicking the button will disable the grid.

•	  Grid visibility disabled. Clicking the button will enable the grid.
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Working with Multiple Grids
On top of regular controls, grid visibility can also be adjusted, if the user wants to display 
only some grid levels in 3D view.

Grid visibility can be controlled by the grid visibility button in the left toolbar.

This button is shown only if there is at least one grid enabled in the 3D. If all grids are 
disabled, that button will be disabled too. Clicking the arrow opens the grid level menu. 
From there, users can choose which grid levels are shown. By default, only the elevation 0 is 
shown.

Checking the different grid levels makes them visible in the 3D, un-checking hides them. All 
visibility settings done to grids can be saved as part of a View.

Note

If a grid is disabled in the Models Tab, it won’t appear in the list. 



﻿Trimble Connect for Windows  ›  Working in 3D: Objects 111

Working in 3D: Objects
The Objects Tab is a tool that allows to colorize, sort, order and filter objects based on object 
attributes.

Using the Objects Tab with the 3D View
The Objects Tab can be used to interact with the model objects shown in the 3D view.

•	 When objects/object groups are selected in the Objects Tab, objects get also selected 
in the 3D view. 

•	 When hovering over objects/object groups, objects will be highlighted in the 3D view. 

•	 Right clicking objects or object groups will select them and open the context menu.

Choosing Objects to Display in the Tab
You have several options to decide which objects are shown in the Objects Tab. There are 
three different options available through the Show dropdown: All objects, visible objects, or 
objects in view.



﻿Trimble Connect for Windows  ›  Working in 3D: Objects 112

OPTION DESCRIPTION

All objects All objects are shown in the Objects Tab, independently of their 
visibility in 3d view.

Visible objects Only the visible objects are shown in the tab. When hiding an 
object, it will disappear from the tab.

Objects in view Only the objects that are actually shown entirely or partially in the 
current 3D view are found in the Objects Tab. 

This means that when navigating the 3D view, the content of the 
Objects Tab will change accordingly. A red dot can be seen next to 
the dropdown when navigating, indicating that the object list will 
be updated. Once the dot disappears, the list is updated. 

Any hidden objects will not be listed.

Visibility & Color
The Objects Tab enables you to change the object's visibility and colors. By default, all 
objects from the currently loaded model(s) are shown in the Objects Tab, and they are 
grouped by Object names. 

Visibility Controls

OPTION DESCRIPTION

 Object groups and objects can be hidden/shown by clicking the visibility icon. 
Changing objects visibility has no effect on model loading (hidden objects are 
still loaded in 3D view). Loading cannot be controlled from the Objects Tab.

 Model color and transparency can be changed using the color icon. If an object 
group contains objects of different colors, the multicolor icon is used. If all 
objects in the group have the same color, the color indicator will use that color. 
The transparency is always 0% by default.
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Change an Object or Object Group’s Color
Color and transparency are set from the color customization dialog, which open when 
clicking the color icon:

•	 Once color and transparency have been changed, they are reflected by the color 
indicator. 

•	 When changing color and transparency for an object group, it is changed for all 
objects in the group accordingly. 

•	 Multiple objects/object groups can be selected at once using CTRL + click. 

•	 Changing color or visibility for several objects or object groups is done using the right 
click context menu. 

Working with Object Groups
For the object group, there is an arrow on the left side of the row, which allows you to 
expand or collapse the group when clicked. The number next to the object group name 
indicates how many objects are in the group.

Once expanded, objects in the group are shown under the group.

The Objects Tab can also be used to colorize, group, sort and filter objects, and then work 
with objects based on that filtering.
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Changing the Column Content
Users can also change the column content by right clicking the column header. Only the two 
middle columns content can be changed. 

•	 Column 1: Shows the color and visibility, 

•	 Column 2: The default is Object name, but this can be changed to show different 
content

•	 Column 3: The default is Author name, but this can be changed to show different 
content

•	 Column 4: Show clashes.

Once a user has chosen a new attribute to be used for sorting, the column will change 
accordingly. Next to group names will also be shown the sum of quantities for the chosen 
attribute, for all objects in the group. This sum is calculated using the original accuracy of 
values.
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Colorize Object Groups
Objects can be colored from the Objects Tab using the Colorize groups button. Objects are 
colorized according to the current grouping. 

Colorize by Quantities
If the grouping is done using quantities (weight, elevation, etc...), colors are applied gradually 
for the groups, from green (#12FF00) to red (#FE0000).

Colorize by Text Based Properties
If the grouping is done using text (object name, assembly mark,etc...), then the colors from 
the default palette are applied, and cycles through them. Once reaching the last color, the 
first color from the palette is applied again.

The Reset colors button can be then used to get back to default color for all objects in the 
project.
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Change Object Grouping 
Use the Group by feature to group objects by any attribute existing in the project. Grouping 
is done through a dropdown menu in the top right part of the Objects Tab.

•	 By default, objects are grouped by Object names.

•	 To remove object grouping select the empty option from the dropdown menu.



﻿Trimble Connect for Windows  ›  Working in 3D: Objects 117

Sorting Object Groups
Sorting can be ascending or descending. This is indicated by the blue arrows next to the 
column used to do the current sorting.

•	 Sorting can be done by clicking columns. 

•	 Clicking the same column a second time will change the sorting order.

•	 Any object attribute existing in the project can be used to sort objects.

Search & Filter Objects
Objects can also be filtered by using the filter field. Only objects that are matching the search 
criteria will be shown in the Objects Tab. 

•	 The filter will search any of the object’s attributes, not just the ones used to group or 
sort the objects.

•	 The filtering can be cleared by clicking the Remove button next to the filter field. 

•	 Once the filter field is cleared, all objects are grouped and sorted as prior to filtering 
them.
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Object Details & Properties 
The Object Details Tab can be opened by double clicking an object, clicking the object name 
in the context menu, or by clicking the object and pressing the ENTER key.

All available details about the object can be found in the object’s properties tab. For 
elevation, no unit will be applied, the value will be displayed as given in the ifc file.

If there are clashes associated with that object, they are also shown here. The list of 
associated clashes can also be expanded/collapsed by clicking the arrow next to it.

OPTION DESCRIPTION

Zoom to object Zooms to the selected object(s)

Select object Selects the object(s) in the 3D view

Files  Adds a File attachment
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OPTION DESCRIPTION

ToDos  Links the selected object(s) to a ToDo

URLs  Adds a URL attachment

Quick Tip

Object properties can be copied and pasted by clicking any properties, right click + Copy or 
using CTRL + C.

Object Attachments
Object attachments or object links are files, ToDos, or URLs that have been specifically linked 
to a particular model object. They can provide specific instructions or important information 
related to that object.
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Adding Object Attachments
Objects can be linked to files, ToDos, and URLs by selecting the object and right clicking to 
open the context menu. 

OPTION DESCRIPTION

 Add a ToDo to the selection 

 Add a file to the selection 

When clicking the link file to the object button, a dialog opens to let the user 
choose which file he wants to link to the object or object group. Both files in 
the project or from the computer can be linked here.

 Add a URL link to the selection
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View Object Attachments

View Attachments in the 3D View
When linking objects to files, ToDos or URLs, the corresponding icon is then shown on top of 
these objects in the 3D view.

 

OPTION DESCRIPTION

 Once files to be linked are chosen, clicking OK will link them to the object or 
object group. Once an object is linked to a file, this icon is shown on top of 
the object in 3D view.

 
When clicking the link ToDos to the object button, the ToDo creation dialog 
opens and ToDo can be created as usual. Once the ToDo is saved, the object 
is linked to it, and this icon is shown on top of the object in 3D.


When clicking the link URL to the object button, a dialog opens, asking the 
user to choose the URL and its name.
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View Attachments in the Object Context Menu 
Links are also visible from the object context menu, where related ToDos and files are also 
shown. Links can be removed from the object using the contextual and by clicking the Trash 
() button.

 

View Attachments in the Object Detail Tab 
Attachments are visible from the Object Details Tab. From there, the user can access the 
related ToDo by clicking it. Files, ToDos and URLs links can also be added/removed using the 
corresponding Trash () buttons.
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Object Attachment Permissions
Only the user who added the attachment, or the Project Admin, can remove an attachment 
in Trimble Connect for Windows. 

Change Object Attachment Visibility
Links icons in 3D can be shown/hidden from the visibility toolbar on top of the 3D view, by 
using the Object Links button.
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Working in 3D: ToDos
The ToDos tab is used to create and manage ToDos to communicate information with all 
stakeholders throughout the project.

The ToDos list displays the ToDos added to the project. You can add ToDos and collaborate 
with other project members. ToDos are shared to all project members by default, but you 
can select a user or a user group to assign the ToDo with a due date when it needs to be 
resolved.

You can dock or undock the ToDos list, and move it around the 3D view.

Creating a ToDo
ToDos can be created by clicking Create a ToDo from the toolbar in the 3D view or from the 
ToDo Tab.

To Create a ToDo:

1.	 Click the Create a ToDo () button.

2.	 The ToDo Creation Tab opens.

3.	 The current 3D view is added to the ToDo by default as attachment.

4.	 Enter the required information: Title and Description

5.	 Add the optional information, such as, Priority, Type, Status and Due Date.

6.	 Click Submit.
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Embedded Views
By default when creating a ToDo, the current 3D view is added to the ToDo as an embedded 
view. For the embedded view, the number of models shown when creating the ToDo is given 
next to the view in the ToDo. 

ToDo Labels
ToDo label is created automatically, and has always the same format: four first letters of the 
project and its number; i.e. if the project is called Tekla House, the first ToDo label will be 
TEKL-1. If the name of the project is changed later on, the four first letters used are still the 
original name ones.
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Assigning ToDos
You can only assign the ToDo if you are the administrator of the project, or if you have 
created the ToDo.

ToDos can be assigned to multiple users at once, and to user groups. All project members 
are listed in the dropdown, in alphabetical order, surname first. If there is no assignee, the 
field is left empty, which is the default option.

Hovering over project members' names in the list shows their email address as tooltip. 

To Assign a ToDo:

1.	 In the ToDos list, double-click the ToDo you want to assign

2.	 Click the Edit button.

3.	 Click the Assignee box and select the project member or user group in the list.

4.	 You can also start typing the name of the user or user group to filter the user list.

5.	 Click the calendar on the right side of the Due date box, and select the due date on 
the calendar.

6.	 Set the priority and the status of the ToDo, if needed.

7.	 Click Save to save the changes.
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Commenting on ToDos

Add a Comment to a ToDo 

1.	 Open the ToDo and click the Comment field in the bottom of the ToDo.

2.	 Write a comment

3.	 The Add comment and Cancel buttons appear. 

4.	 Click Add comment to save the comment

5.	 Views and files can also be added to comments, in the exact same manner as ToDo 
attachments.

More information on Comments can be found in the 
Trimble Connect for Browser User Guide 

https://drive.google.com/file/d/15OzgnJ29b0PCXyXL9xyZpMIBBuGHMBOm/view?usp=sharing
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ToDos Tab

Understanding the ToDo Listing
ToDos information are shown as follows:

•	 First row

•	 ToDo label 

•	 ToDo title

•	 Total number of comments in the ToDo, shown between brackets

•	 Second row

•	 Author

•	 Assignee 

•	 Due Date

•	 Status

•	 Priority
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Quick Tip

•	 Hovering over the title/description to see the full text

•	 Hover over the author or assignee to see the email address

Synchronizes ToDos from the Cloud
ToDos tab can be synchronized on demand by clicking the Synchronize button, to make sure 
the latest ToDos are shown in the ToDos tab, and are up to date.

Group ToDos
Grouping is done through a dropdown menu in the top right part of the ToDos tab. ToDos 
aren’t grouped by default. Grouping options are: 

•	 Author
•	 Status
•	 Priority
•	 Type
•	 Tag
•	 Creation date
•	 Last modified date
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Sort ToDos List
All columns can be used to sort the ToDos. By default, ToDos are sorted by Creation date 
(latest ToDo on top).

Sorting can be ascending or descending. This is indicated by the blue arrows next to the 
column used to do the current sorting.

Search ToDos
ToDos can also be filtered by using the search field. Only ToDos that are matching the search 
will be shown in the ToDos Tab. 

Search by 
•	 Description
•	 Author
•	 Tags 
•	 Assignee

More information on ToDos can be found in the 
Trimble Connect for Browser User Guide 

https://drive.google.com/file/d/15OzgnJ29b0PCXyXL9xyZpMIBBuGHMBOm/view?usp=sharing
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Managing ToDos
When opening a ToDo, and depending on user rights, ToDo can be edited. Admin users can 
edit and remove any ToDo in the project. The ToDo creator can edit and remove its own 
ToDos. ToDos assignee can only edit the ToDos assignee field.

Depending on the user permissions, the Edit and Remove buttons will be shown.

Edit a ToDo
1.	 Open the ToDo Tab.

2.	 Double click the ToDo.

3.	 Click Edit.

4.	 The ToDo creation tab switches to editing mode, where editing of all fields is enabled 
for admin and ToDo creator. 

5.	 After the changes have been made click Save.

Note: Views cannot be edited within ToDo, they can only be removed/added.

Delete a ToDo 
1.	 Open the ToDo Tab.

2.	 Double click the ToDo.

3.	 Click Remove.

Note: The ToDo will be permanently deleted (this cannot be undone).
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ToDo Attachments
ToDos support 5 attachment types, and depending on the type of attachment and 
depending on your role and the project permissions, different functions will be available for 
each.

Attachment types:

•	 Project Files

•	 Local Files

•	 3D Views

•	 2D Views

•	 Clashes

Add Attachments

Attach Project Files

1.	 Open a ToDo and click Edit.

2.	 Click Add attachment… ().

3.	 This opens the Add Attachment Dialog, which displays the project File Explorer. 

4.	 Select the file to be attached. 

5.	 Click OK.  
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Attach Local Files

Using the Attachment Dialog

1.	 Open a ToDo and click Edit.

2.	 Click Add attachment… ().

3.	 The Add Attachment Dialog will open.

4.	 Click the 2nd tab () in the same dialog.

5.	 Click Add from my computer…

6.	 The Windows Explorer opens. 

7.	 Files can be chosen from there and will be added as attachment to the ToDo after 
you click OK. 

Drag & drop
Files can also be now dragged and dropped from the computer directly to the ToDo (while it 
is in editing mode).
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Attach 3D Views

Using the Attachment Dialog

1.	 Open a ToDo and click Edit.

2.	 Click Add attachment… ().

3.	 The Add Attachment Dialog will open.

4.	 Click the 3rd tab () in the dialog.

5.	 All Views that you have access to will be shown.

6.	 Select the Views. 

7.	 Click Ok. 	

Drag & drop
Views from the Views Strip can be also attached to the ToDo by dragging and dropping them 
from the Views Strip into the ToDo.
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Attach 2D Views

1.	 Open a ToDo and click Edit.

2.	 Click Add attachment… ().

3.	 The Add Attachment Dialog will open.

4.	 Click 2D Views in the dialog.

5.	 All 2D Views that you have access to will be shown.

6.	 Select the 2D Views. 

7.	 Click Ok. 

Attach Clashes

1.	 Open a ToDo and click Edit

2.	 Select the clashes in the 3D view 

3.	 Click the  Add Clash button. 

4.	 The number of attached clashes is shown next to these buttons.
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Working with Attachments
•	 Double clicking the file will download it to the project if it was on the cloud only. 

•	 If the file has already been downloaded already, it will be open in 3D if it is a model, 
or with default software if it isn’t. 

•	 The file attachment is actually a link between the ToDos and the chosen file, which 
means that if the file is updated, it will be updated in the ToDo as well. 

•	 Double clicking a View will load the view in 3D.

Remove Attachments

Remove Attached File or Views
Files and Views attached to ToDo can be removed by clicking Remove the attachment () 
on the right side of the view when in editing mode.

Remove Clash Attachments

1.	 Open a ToDo and click Edit

2.	 Select the clashes in the 3D view 

3.	 Click  Remove Clash button.
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Link Model Objects to a ToDo
If a ToDo is relevant to a particular model object or objects, you can associate the object(s) to 
a ToDo.

Link Objects to a ToDo
1.	 Open a ToDo and click Edit.

2.	 Select the objects in the 3D view. 

3.	 Click Link selected objects.

The total number of linked objects can be seen in the View linked objects button.

Remove Linked Objects
1.	 Open a ToDo and click Edit.

2.	 Select the objects in the 3D view  

3.	 Click Unlink selected objects.

View Linked Objects in 3D
Linked objects can be shown in 3D by clicking the View linked objects button. This will 
select and fit to view the linked objects.
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Working in 3D: Clashes
A clash is a structural conflict within a 3D model. Clash reports provide detailed Views of the 
clashes in the 3D model, showing a clearance as a positive measurement and a clash as a 
negative measurement.

Clash Sets
Clash sets can be created in Trimble Connect for Windows by clicking Add new clash set 
(), found in the upper right corner of the clashes tab.

Clash Set Parameters
Clicking Add new clash set () opens the parameters dialog, allowing you to define the 
parameters for the clash set.
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OPTION DESCRIPTION

Models in clash set From that dialog, models to be used for the clash set can be picked. 
Because the clash processing engine is cloud based, only models 
that are stored in the cloud (pushed to the server) are shown in the 
list and can be used for creating a clash set. 

If a model isn’t pushed yet, it is shown in red in the list. The tooltip 
indicates the user what to do in order to be able to use that model 
in a clash set.

Name Name for the clash set is mandatory and needs to be defined 
before the clash set can be created. Once a name has been 
defined, the OK button will be enabled.

Clash type There are two types of clash sets: Clash and Clearance.

Clash: Use this option to find objects that collide or interfere with 
other objects with a specified tolerance.

Clearance: Use this option to find objects that are within a 
specified distance of one another.

Tolerance Tolerance is either the conflicting or clearance distance between 
objects, depending on which clash set type has been chosen.

Ignore clashes within 
the same file

Checking this option will disregard any clashes that exist in the 
same file.
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OPTION DESCRIPTION

Ignore clashes within 
the same type

Checking this option will disregard any clashes of the same object 
type. This can be useful when you are detecting a clash between 
two trades or disciplines. 

Shared with Users the clash set will be shared to can also be defined here, by 
clicking the Share dropdown and checking the user from the list.

Create a Clash Set
1.	 In the side pane, click Clashes () to open the Clashes Tab. 

2.	 In the upper-right corner of the Clashes tab, click Add new clash set ().

3.	 In the Clash set parameters dialog box, type the clash set name.

4.	 In the Models in the clash set section, select at least 2 models in which you want to 
detect clashes.

5.	 Select the clash type.

6.	 Specify the clearance or tolerance.

7.	 To leave out clashes within the same object type or element type, select the Ignore 
clashes within the same type checkbox.

8.	 In the Shared with list, find and select the users and user groups with whom you 
want to share the clash set.

9.	 Click OK.

The new clash set will be added to the Clashes side pane. Trimble Connect for Windows 
ensures that the model has been converted to a TrimBIM model, and then, runs the clash 
check.

Clash check status is now shown with a circle progress indicator, with progress percentage 
in the tooltip. During clash check run the manual clash sync button is disabled because 
accelerated clash sync is carried out in the background to give almost real-time progress 
info.
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Sharing a Clash Set
Clash sets are not shared by default when creating them. If the clash set wasn’t shared at 
creation, one needs to open the Clash Details Tab, click the sharing dropdown, and then 
check users in the list. 

All users checked in the list will see the clash set and related clashes appear in their project 
soon after it has been shared with them. The sharing list works in the same way than any 
other sharing list in the application. This can also be done by editing the clash set.

Clash Set Grouping
When grouping the clashes by clash sets, each group represents a clash set. The clash set 
contains all clashes found when running it, and can be expanded/collapsed as needed.
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Clash Sets & Model Versions
If one or more of the models that was used when running a clash set has been updated (ie. 
a new version is available), the related clashes are shown in red in the clashes tab (and are 
removed from the 3D View anymore), indicating that models have been updated, and that 
clash set needs to be rerun. 

Quick Tip

If you load the previous model versions that were used in the clash set, the icons will be 
shown in 3D.

Re-run a Clash Set 
Clash sets can also be re-run and updated from Trimble Connect for Windows, by clicking 
Re-run clash set ().

To re-run a clash test without changing the clash set parameters:

1.	 In the Clashes side pane, click Re-run clash set () on the right side of the clash 
report.

2.	 Click Ok.

When clicking Re-run clash set (), the same clash parameter dialog opens. New settings 
can be defined, in the same manner than at clash set creation. Once the settings have been 
updated, clicking OK will re-run the clash test with the new settings and report the results 
accordingly shortly after.
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Clash Set Details Tab
Double-clicking a clash set in the list opens the Clash Set Details Tab. It contains all the 
details available for the rule set.

In the Clash Set Details Tab, details such as clash set name, number of found clashes, 
tolerance and clearance distance used when running the clash set are found. It also includes 
the creator name, date of creation, and who the clash set has been shared with is shown. 
Users can control who the clash is shared with from here.

Edit & Re-Run a Clash Set

1.	 In the Clashes side pane, double-click the name of a clash set.

2.	 The Clash Set Detail Tab will open.

3.	 To change or edit the clash set properties, click Edit and re-run...

4.	 In the Clash set parameters dialog box, modify the clash set properties according to 
your needs.

5.	 Click OK to save the changes and re-run the clash or clearance detection.
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Delete a Clash Set
It is possible to remove the clash set through contextual right-click menu, or by using the 
Trash () button. 

A dialog asks removal confirmation from the user before the clash set is deleted. 

When deleting a clash set, it is deleted permanently including all clashes it contained, and for 
all users it was shared with. 

Clashes
Each clash is shown in a row, and there are only two columns shown in the clashes tab. The 
format for the clash’s name is Clash-XXX, where XXX represents the running number. Objects 
column shows the clashing object names.

When selecting a clash in the list, the corresponding flag and the related clashing objects are 
selected in the 3D view. If the user selects a clash and then uses Show only from the toolbar, 
only the objects involved in the clash will be shown in the 3D view.

•	 Clashes can be grouped by using the grouping dropdown. 

•	 There are only two grouping options available at the moment: by clash sets or by 
object names. 

•	 Clashes are grouped by clash sets by default. 

•	 Sorting or filtering isn’t available in clashes tab.
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Clash Context Menu Functions

OPTION DESCRIPTION

Show clash set  Opens the related Clash Set Details Tab

Open Opens the actual Clash Details Tab.

Clash Details Tab
The Clash Details Tab gives you more information about a specific clash. 

OPTION DESCRIPTION

Select Objects
All related objects can also be selected from the details tab by 
clicking the Select Objects button.

Clashing objects Clashing object names are actually buttons, which when clicked, 
select the related object and fit it to view. This doesn’t affect objects 
visibility.

Distance between 
objects

Physical distance between objects
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OPTION DESCRIPTION

Shared with Who this specific clash is shared with are found. 

Note: Sharing cannot be changed from there though, it needs to 
be done at the clash set level.

View Clash Details
1.	 To view all clashes in a clash report, click the arrow () on the left side of a clash 

set.

2.	 Find and double-click a clash whose details you want to see.

3.	 The clashing objects, distance, and sharing information is shown.

4.	 To select the clashing objects in the 3D view, click Select objects.

5.	 When navigating back to the clashes tab, the clash will still be selected in the list.
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Clashes in the Objects Tab
In the Objects Tab, the most right column displays the number of clashes related to an 
object. The number next to the clash symbol indicates how many clashes are associated with 
the object.

•	 If only one clash is associated with the object, clicking the clash symbol will directly 
open the Clash Details Tab. 

•	 If there are several clashes, it will then open the list of associated clashes.  
Clicking one of them in the list will open the related Clash Details Tab.

•	 The list of clashes associated with an object is also displayed in the Object Details 
Tab. Please see Object Details & Properties for more detailed information.
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Clashes & ToDos
Another way to share clashes is to attach clashes to ToDos. However, corresponding clash 
sets need to be shared first in order for the clash to appear in other users' 3D View.

When editing ToDos, clashes can be added as attachments from the attachments section. 

Attach a Clash to a ToDo
1.	 Open the ToDo Detail Tab

2.	 Click Edit.

3.	 Select the clash in 3D.

4.	 Click the Add button. 

5.	 Once attached, the number of attached clashes is also shown. 

Remove a Clash from a ToDo
1.	 Open the ToDo Detail Tab.

2.	 Click Edit.

3.	 Select the clash in 3D.

4.	 Click Remove.

5.	 The clash will be removed from the ToDo. 

6.	 The number of attached clashes will be updated accordingly.

Please see "Working in 3D: ToDos" on page 124 for more information on ToDos.
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Clashes in 3D
Once a clash set has been created and finished processing, clash flags are shown in the 3D 
View.

You can control the Clash flag visibility by toggling this option from the left side toolbar. This 
will show or hide all clashes at once. Clash are visible by default.

Clash Flag States

ICON DESCRIPTION

 Full Opacity

Both objects related to a clash are visible in 3D.

 Semi-transparent

Only one of the objects related to the clash is visible.

 Selected state
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Single Flag vs. Clusters

ICON DESCRIPTION

 Single Clash Found

When only one clash is found in a certain area (based on the current camera 
position and zooming in 3D view), a single clash symbol is shown. In that case, 
here are the different options:

•	 Clicking the clash symbol selects the associated clash in the clashes tab 
and the related objects in the 3D view.

•	 Double clicking the clash opens the Clash Details Tab and fits the 
related objects to view.

•	 Right clicking opens the context menu (Open), from which Clash Details 
Tab can be opened.


12 Many Clashes Found

If there are many clashes found in a certain area (based on the current camera 
position and zooming in 3D view), a cluster flag is shown.

This flag actually represents several clashes. This number indicates how many 
clashes are represented by that cluster flag. Selection states are the same as 
for single clash flags.

Cluster flags are updated while navigating, without interrupting the navigation.

In case of cluster flag, the different options are as follow:

•	 Clicking a cluster will zoom in and split the cluster into several flags/
cluster flags depending on the size of the cluster. All objects related to 
flash in the cluster are selected.

•	 If several clashes are found exactly at the same place, clicking the 
symbol on 3D opens a list of clustered clashes. Clicking then one of the 
clashes in the list opens the related Clash Details Tab. Next can be seen 
the list that opens when clicking a cluster for which clashes are at the 
exact same place.

•	 Double-click has the same effect as a single click.

•	 Right click behavior is disabled for clusters.
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Working in 3D: Views
You can save model Views, or snapshots of the 3D View, and manage them in several ways 
using the Views list. For example, you can create a slideshow based on the existing model 
Views, save model Views on your computer as images, and set a model view as the project 
thumbnail.

The Views Strip is used to save Views of the models from different camera angles and with 
different colors, object visibility, and markups. These Views are saved and can be reused and 
shared with other members of the project.

Views
Views are created by using the Create view () button in the left side of the Views Strip. 

•	 When a View is created, it appears as the last one on the right side of the Views Strip. 

•	 If the Views Strip is full, it will scroll so that the newly created view is displayed. 

•	 When creating a view, the view name field is selected and it can be renamed directly 
after creation. 
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•	 The default view name is New View.

•	 The Views Strip can be reorganized if needed by drag and dropping Views. The view 
will move to where it is dropped.

When creating a View, the 3D view and its content is saved. This includes the following: 

•	 Camera angle and zooming
•	 Color and transparency changes
•	 Object visibility changes
•	 Measurements
•	 Markups
•	 Clip planes
•	 Grid visibility
•	 Clashes visibility
•	 Ghost mode
•	 Orthogonal/Perspective mode 

Views Context Menu Functions
Right clicking on a View exposes the context menu.

OPTION DESCRIPTION

Group Views can be grouped together.

Update Views can be updated if needed by right clicking the view, and 
selecting Update. The current 3D view content will then overwrite 
what was previously saved in the view. The view snapshot is also 
updated accordingly.

Remove Views can be removed by right clicking, Remove. A dialog asks the 
user to confirm the removal. Several Views can be removed at 
once.
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OPTION DESCRIPTION

Add to Data Tab Views can be added to the Data Tab, by right clicking, Add to data 
tab. The view will then be available in the Data Tab when opening 
the project. 

Attach to a ToDo Views can be attached to a ToDo. 

This is available only if a ToDo is currently in editing mode in the 
ToDos tab. Once the view is added to the ToDo it also appears 
under the attachment section of the ToDo.

When a View is shared through ToDos, it only appears in the 
related ToDo, not in the user Views Strip.

Please see "ToDo Attachments" on page 132 for more 
information.

Set as project image View can also be set as project thumbnail by right clicking, Set as 
project thumbnail. 

Project thumbnail is shown in both project library and Data Tab.

Share… Views are by default private. For other project members to see the 
view it must be shared explicitly with them. 

For more information on View permissions see 
Trimble Connect for Browser User Guide .

Load with original 
model versions

Since there can be several versions of a model in the same project, 
there is also an option to load the view using the original model, 
meaning the model version used at view creation. Otherwise, the 
view will be loaded using the currently used version of the model.

Create a View
1.	 To open the Views Strip, click Views () in the side pane.

2.	 The Strip will appear at the bottom of the application.

3.	 Adjust the model to any position that you would like to capture a View of. 

4.	 On the right side of the Views Strip, click Create view () .

5.	 The current 3D View is saved and added to the Views Strip.

6.	 In the box below the View, type a name for the View.

https://drive.google.com/file/d/15OzgnJ29b0PCXyXL9xyZpMIBBuGHMBOm/view?usp=sharing
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Loading a View
Double clicking a View will load the View in 3D. 

•	 The View will have an active state to indicate which View is being shown in 3D

•	 If the models in the view are not loaded when double clicking a View, they will be 
loaded accordingly. 

•	 Any extra models that aren’t needed are just hidden, so that switching between 
remains smooth and doesn’t always require the model to be loaded/unloaded.

Update a View
1.	 To open the Views Strip, click Views () in the side pane.

2.	 In the Views Strip, right-click the View that you want to replace.

3.	 Select Update.

Note: Updating a saved View will replace the originally saved View with the current View.

Load a View with Original Models
1.	 To open the Views Strip, click Views () in the side pane.

2.	 In the Views Strip, right-click the view that you want to load with previous models.

3.	 Select Load with original model versions.

4.	 The saved View is reverted to use the original model versions that were used to 
create the View.

Save a Model View as an Image
1.	 To open the Views Strip, click Views () in the side pane.

2.	 In the Views Strip, select the View that you want to export as an image.

3.	 Click Export current 3D view as image.

4.	 In the Save view as image dialog box, type a name for the image.

5.	 In the Save as type list, select the file format.

6.	 You can also change the file type by typing another image file extension to the File 
name box.

7.	 Click Save.
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Delete a Model View
1.	 To open the Views Strip, click Views () in the side pane.

2.	 In the Views Strip, right-click the View that you want to remove.

3.	 Select Remove.

4.	 Click Yes to confirm.

Note: The View will be deleted, including any user it had been previously shared with. 

View Groups
View Groups are a collection of Views. 

•	 Double click a group to open and display its contents in the Views Strip. 

•	 The name of the group also appears in the top left corner of the Views Strip. 

•	 Views can be created directly inside the group

•	 Groups cannot be created from within another group

•	 Clicking the arrow located next to the View Group name allows you to go back to the 
Views Strip main level.
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Create a View Group
1.	 Select one or several Views

2.	 Right click

3.	 Select Group from the context menu

	 Alternatively 

You can also drag and drop a View on top of another one to create a group.

4.	 The View Group is created.
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View Group Context Menu Functions
View Groups also have contextual right click menus.

OPTION DESCRIPTION

Ungroup Groups can be ungrouped by right clicking to open the context 
menu and then selecting Ungroup.

Remove Removing a View Group will permanently delete the View Group 
and all the Views inside it. 

Share Shares a View Group with other project members.

Note
Sharing a View Group does not share all the Views inside that 
group.
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Remove a View from a Group
To remove a View from a group, right click on the View inside the View Group to open the 
context menu. The option to Group the View is replaced by the Ungroup option. 

•	 When ungrouping a View, it is removed from the group and goes back to the Views 
Strip. 

•	 When ungrouping the last View in a group, the group is also removed from the Views 
Strip.

Rename a View or View Group
1.	 Click the name field of the View or View Group.

2.	 Enter the new name.

3.	 Press the ENTER key.

4.	 The View or View Group will be updated with the new name.

Share a View or View Group
Views are automatically pushed to the server when creating them. These Views can be used 
on multiple devices for the same user. However, by default, Views aren’t shared with other 
users in the project, which means that only the View creator can see their own Views in the 
Views Strip. 
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Shared Views gives the recipient full edit functionality.

1.	 To open the Views Strip, click Views () in the side pane.

2.	 In the Views Strip, right-click the View or View Group that you want to share with 
other users.

3.	 Select Share...

4.	 In the Select users and groups dialog box, find and select the user groups or users 
with whom you want to share the View.

5.	 Click Save.

Note: Sharing a View Group does not share all the Views inside that group. 

Unshare Views
If you don’t want Views to be shared anymore, you can repeat the same process used for 
sharing them, and uncheck everyone in the list. The list always allows you to know whom a 
specific View is shared with. 
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Filter & Search Views

OPTION DESCRIPTION

Own views 
Default state of the Views Strip. This shows all Views you have 
created and that have been shared with you.

Shared with me 
This filters the Views to show only Views shared with you.

To know who has shared a view, hovering over a shared view 
will display the tooltip Created by <user name› (this is only 
shown when the list is filtered for Shared with me).

While in this filtered view, the only control the user can do is 
Load with Original Model Versions.

Note
Because shared Views appear in the Own Views Strip, a user 
will be able to edit shared Views.

Users can search the Views Strip and easily find created Views 
using the search field on the right side of the Views Strip. 
When searching the Views Strip, only matching Views and 
groups are shown. Opening a group also only shows matching 
Views within that group. 

The Search can be cleared by clicking Remove () next to it.

Play a Slideshow with Views
The slideshow function can be used as soon as there is more than one View saved. The Play 
slideshow button is disabled until some Views have been created.

Right before starting the slideshow, Trimble Connect for Windows checks which models are 
required to be loaded so that all the Views are displayed correctly during the slideshow. 

•	 If there are other models needed for the slideshow, they will be loaded before the 
slideshow starts. A dialog will be displayed to indicate the loading.

•	 These models will stay loaded in 3D after stopping the slideshow.

•	 Clicking cancel while the models are loading will cancel the loading, and the 
Slideshow will not start.



﻿Trimble Connect for Windows  ›  Working in 3D: Views 161

Play a Slideshow
When the slideshow starts, the Views Strip goes into slideshow mode. This means that only 
the Views that are going to be played during the slideshow are now displayed in the Views 
Strip. The slideshow starts from the last selected View.

The Views Strip header indicates that slideshow is playing, and the Stop slideshow button is 
displayed instead of the play and settings button.

Play a Slideshow for Ungrouped Views

1.	 Click Play () from the Views Strip or select some Views and click Play ().

a.	 In the case where there are both Views and groups selected, groups are just 
skipped while running the slideshow.

2.	 The Views Strip will go into Slideshow mode and all of the selected Views are shown 
as a slideshow.

Play a Slideshow for a View Group

1.	 Select a single View Group or open the View Group.

2.	 Click Play ().

3.	 The Views Strip will go into Slideshow mode and all of the selected Views are shown 
as a slideshow.

Exit a Slideshow
To exit the Slideshow mode, click Stop slideshow. The Views Strip will return to its normal 
state, where all created Views are shown. 

•	 Slideshows will also stop if any navigation is done in the 3D View.

•	 The Views that were selected before you entered the mode will still be selected in the 
Views Strip when you stop the slideshow. 



﻿Trimble Connect for Windows  ›  Working in 3D: Views 162

Slideshow Settings
Settings can be defined for the slideshow by clicking the slideshow settings button. 

OPTION DESCRIPTION

View Duration This represents the time a View is displayed before 
switching to the next one. The default value for the 
View duration is 1. If the View duration is set to 0, then 
the slideshow will just go from one view to another 
without pausing at all.

Duration of camera animation The default value is 3 seconds. The maximum value 
that can be set is 10 seconds. When trying the set a 
camera animation of more than 10 sec, the value is 
automatically reverted to 10.

Show in fullscreen mode By checking the Show in fullscreen mode box, the 
slideshow will automatically play in full screen. Once 
the slideshow ends, the interface will go back to 
normal.
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Working in 3D: Sequences

Overview
This feature gives users a walk-through of the steps involved in the construction of a model 
from scratch in a specified order. The purpose of this is for verification and construction of 
large models, created from several smaller models, over time. 

•	 To fully utilize this feature, the user must have a HoloLens headset and the Trimble 
Connect for HoloLens application installed. 

•	 This feature is supported only in Online mode in Trimble Connect for HoloLens. 

•	 Sequences can only be created in Trimble Connect for Windows. 

•	 When a Sequence is created, a Metadata.mrdb file is added to your project. 

•	 It is advised to perform a project sync before working with a Sequence so that the 
latest changes to the Sequence are updated locally. 

•	 Creating or editing a Sequence before the Metadata.mrdb is downloaded (or before 
the project sync is complete), might overwrite the existing Sequence contents and it 
is not reversible).

See this feature in action:

Creating a Sequence in Trimble Connect for Windows

Sequencing a Model in Trimble Connect for HoloLens

https://youtu.be/dFIcvtWRzek?t=286
https://youtu.be/CDRWCp-tCYQ
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Accessibility of Model & Objects Windows
Users can work with Sequence window and Model or Object Windows simultaneously. To 
achieve this, the Sequence Tab can be undocked.

Object States

STATE DESCRIPTION

Visible State When you first start a sequence, all objects will be in the visible 
state, meaning they do not belong to any steps yet. 



﻿Trimble Connect for Windows  ›  Working in 3D: Sequences 165

STATE DESCRIPTION

In Use State Objects that belong to the selected step are shown in the In Use 
state. They will appear slightly darker than the other visible (used 
objects).

Hidden State Objects that belong to the non-selected step are shown in a hidden 
state.

Create a Sequence
A sequence can have multiple steps. Each step can contain multiple objects, but those 
objects can only belong to only one step at any point in time. Empty steps without any 
objects are discarded when the sequence is saved.

Create a New Sequence
1.	 Load one or multiple models.

2.	 To open the Sequence Tab, click Sequence () in the side pane. 
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3.	 Add a step to the Sequence:

a.	 Create a Step by selecting some objects and click Add Step.

b.	

For each step that is added, a View will be added to the View Group. 
The View Group will maintain the order in which the Steps (Views) are created in. The 
order of Views inside the View Group determines the order of steps.

4.	 To add more objects to steps: 

a.	 Select the step you want to add objects to.

b.	 Select the object(s) in 3D.

c.	 Click Add Object.

5.	 Add more steps to the Sequence by following Step 3 & 4 above.  
Note: As you add objects to the steps then will be hidden when you go to the next 
step in the Sequence.
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6.	 Add notes or instructions into the Instructions field for each step. 

7.	 To delete steps from a Sequence:

a.	 Select a step and click Remove ().
b.	 Any objects in the step will now be available to be used in other steps. 

c.	 The step will be deleted, along with the corresponding View in the Sequence’s 
View Group

8.	 When you are finished, click Save.

9.	 You will be prompted to share the Sequence with other users. Click Ok.

a.	 A new View Group will be added to your Views Strip.

b.	 Sequence View Groups will have the Sequence icon () in the right corner. 
 

Notes

If no steps were added as a part of a Sequence the corresponding View Group will be 
removed when you exit the 3D Viewer.

After the Sequence is saved, the Metadata.mrdb file will be created at the project root 
folder. This file is necessary for the sequencing feature to work as expected. Users are 
expected not to explicitly work with this file.

When the user opens a project, if the Metadata.mrdb file already exists in the project, it is 
mandatory for the user to wait until the Project sync is complete. After the sync is complete, 
the latest sequence details will be available.
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Edit an Existing Sequence
An existing Sequence can be edited or updated. This includes:

•	 Adding new steps

•	 When a new step is added to an existing sequence, you have to explicitly 
share the sequence again with the assignees

•	 If you do not share the Sequence again, the users will not be able to see the 
changes.

•	 Edit existing steps and the content of those steps

•	 Remove steps

Edit a sequence

1.	 Right click on the Sequence’s View Group

2.	 Click Edit Sequence
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Play a Sequence
Users can play the sequence and verify each of the steps within the sequence. Instructions 
that belong to the step played are shown below the step.

To play a Sequence, select the View Group and then click play.

Share a Sequence
A sequence can be shared with multiple users in the project by selecting the View Group and 
clicking Share from the context menu.

Remove a Sequence
A sequence can be deleted by right clicking on the Sequence’s View Group and selecting the 
Remove option from the context menu.
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Working in 3D: Point Clouds
A point cloud is a set of data points in some coordinate system. In a three-dimensional 
coordinate system, these points are usually defined by X, Y, and Z coordinates, and often are 
intended to represent the external surface of an object. Point clouds are now supported in 
Trimble Connect for Windows (since v1.3).

See this feature in action:

Check as-Built Structure with Point Cloud in Trimble Connect 

Point Clouds
Point clouds can be added to Trimble Connect for Windows by clicking the Add button in the 
Point Clouds Tab, and choosing a suitable potree folder or file containing point cloud data.

•	 A Point cloud URL cache has been added and is stored in the default cache location: 
c:\users[username]\AppData\Local\trimble\trimble connect\import\
PotreeURLCache

•	 Location uses the same setting as point cloud import (Settings -› General -› Point 
clouds).

https://www.youtube.com/watch?v=Mii9XeIQPYE&feature=emb_logo
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•	 Cache file max size is can be changed in registry:  
PointClouds.DiskCacheInGigabytes, default value is 10 gigabytes.

•	 Setting cache size to 0 disables caching.

The registry settings are stored in the following hive:  
HKey_Current_User\Software\Trimble\Trimble Connect\Settings

Supported Point Cloud File Formats

FILE TYPE DESCRIPTION

LAS A binary format for storing uncompressed LiDAR (Light Detection 
and Ranging) data.

LAZ A binary format for storing compressed LiDAR (Light Detection and 
Ranging) data.

XYZ A text file format that can be read by Point Cloud Manager.

TDX A file format that can have both point clouds and (panorama) 
images. It can be used for example by transferring data between 
Trimble Realworks and Trimble Business Center.

TZF A highly compressed file format for scanned point clouds used in 
Trimble Realworks.

E57 A format for storing point clouds, images and metadata produced 
by 3D imaging systems, such as laser scanners.

URL Point clouds can also be added through web URL by clicking the 
Add URL button and choosing a suitable URL. 
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Adding Point Clouds
In the Data Tab, a "Point Clouds" folder is created. This folder contains a file that has the 
same name as the point cloud folder; this file contains the path to the actual point cloud 
folder. That way, the folder can be shared easily if it is found in a shared location.

Point clouds can be added to Trimble Connect for Windows by opening the Point Cloud Tab  
() and clicking the Add button in the Point Clouds Tab, and choosing a suitable potree 
folder or file containing point cloud data.

Sharing Point Clouds
Points clouds can also be shared if they are found in a shared location. To do so, upload the 
file that was created automatically in the point clouds folder in the Data Tab, and then share 
the project with other users. Once they open the project and download the file locally, they 
will have access to the point cloud from the Point Clouds Tab.

If the point cloud folder isn’t in a shared location, the point cloud will not be able to be 
displayed in 3D View. This is indicated by the point cloud title being red.

Removing Point Clouds
Point clouds can be removed from Trimble Connect for Windows using the Remove button 
found next to the Add button in the Point Clouds Tab. The point clouds list can also be 
refreshed if needed (when doing changes to a point cloud from the Data Tab, it won’t be 
updated automatically in the Point Clouds Tab).

Viewing Point Clouds in 3D
It is possible to hide/show the model using the visibility icon next to it, like in any other tab.

It is possible to fit the point cloud to view by selecting the point cloud in the list, press space 
bar, or double clicking the point cloud.

The context menu (opened by right clicking) allows you to 

•	 Edit the Point Cloud
•	 Remove a point cloud from the project
•	 Fit the point cloud to view
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Point Clouds Tab

Depth Perception

OPTION DESCRIPTION

EDL The EDL (Eye Dome Lighting) technique is used in Trimble Connect 
for Windows. The EDL allows to enhance a viewer’s perception of 
a point cloud, by adding contour and basic shading. EDL thickness, 
EDL strength, point size and point density values are saved to 
registry so values are remembered between sessions.

Point clouds depth perception can be affected in different ways by 
adjusting the EDL effect. EDL is activated by default when adding 
a point cloud, but it can be disabled by clicking the EDL button. 
When disabled, EDL's thickness and strength cannot be changed 
anymore.
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OPTION DESCRIPTION

Thickness The thickness parameter gives how big of an area around every 
point to include in the calculations, a bigger area resulting in a 
more sensitive distinction between the points. 

Strength The strength parameter sets how heavy of emphasis should these 
distinctions be given. Thickness and strength by dragging the 
related sliders. 

Point Size

Point Density

Point size and density can also be adjusted by dragging the sliders. 
This affects all points currently shown in 3D.

Coloring Point Clouds
When adding a point cloud, the default coloring is used. However, this coloring can be 
changed to use either the points elevation or the model classifications.

Color by Elevation
Once clicking Elevation, the color is defined for all points depending on their elevation. Three 
values have to be defined: 

•	 Top

•	 Middle

•	 Bottom

Elevation values can be changed either by dragging the sliders, or by writing the wanted 
values in the editing fields. The range of possible values for each elevation is defined by the 
others elevation. Thus, the range for Middle elevation is always between the highest value of 
Bottom elevation and lowest value of Top elevation.
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How coloring works:

•	 Points with an elevation equal or above the defined Top value are colored in red; 

•	 Points with an elevation equal or under the Bottom value are colored in blue. 

•	 Points with an elevation included between Top and Bottom values are a blend of 
green and red, or green and blue, depending on the range and middle value. The 
closer from the Bottom value, the more blue; The closer from the maximum value, 
the more red.

Color by Classification
Classifications can also be used as coloring. All points will be colored based on their 
classifications. Classifications colors are shown under the classifications section of the Point 
Clouds Tab. 

Point Cloud Classifications
Once the model has been added to Trimble Connect for Windows correctly, its classifications 
are added under the classifications section. 

Parts of the point clouds can be hidden by using the visibility icons next to classifications. 
Points that belong to that classification will be hidden accordingly.
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Resources & Training Material

Trimble Connect App Store
Trimble Connect Apps expand the capabilities of Trimble Connect by integrating with 
multiple applications to increase workflow efficiency and productivity. 

Accessing the App Store
You can access the Trimble Connect App Store while logged in Trimble Connect by clicking 
the App Store icon in the top right corner. 

You can browse and download available apps that can integrate with Trimble Connect.

https://web.connect.trimble.com/#/store
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Skill Builder Videos

Basics
2D Drawing Review  New

Creating a New Project 

Creating Clash Sets 

Creating Groups & Inviting Users 

Managing Folder Permissions 

Microsoft Office 365 Integration 

Viewing Project Files 

Other
Trimble Connect Visualizer: Constructible Rendering 

Trimble Connect Visualizer 

Creating a Sequence in Trimble Connect for Windows

Sequencing a Model in Trimble Connect for HoloLens

Check as-Built Structure with Point Cloud in Trimble Connect 

https://youtu.be/LySTMS8-Khs
https://youtu.be/ZzdYmTjkKS8
https://youtu.be/EGavaOYp2ug
https://youtu.be/KKldfei9TaE
https://youtu.be/51pYNRUvO7I
https://share.vidyard.com/watch/7UmPeZYbPTQxzkTdYcBwu5?
https://youtu.be/BVst4ZsJf2A
https://www.youtube.com/watch?v=3ndhcLKXJZg
https://www.youtube.com/watch?v=M6pTxTsNJMw
https://youtu.be/dFIcvtWRzek?t=286
https://youtu.be/CDRWCp-tCYQ
https://www.youtube.com/watch?v=Mii9XeIQPYE&feature=emb_logo
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User Guides & Documentation
For more Trimble Connect User Guides and other useful information, click on any of the links 
below.

Specifications
Applications Feature Comparison 

Supported File Formats 

Supported Languages 

Support Policy 

System Requirements 

Understanding Connect Licensing 

Understanding Project Types & Features 

User Guides
Trimble Connect for Browser User Guide 

Trimble Connect for Browser 3D Viewer User Guide 

Trimble Connect for Browser 2D Viewer User Guide 

Trimble Connect for Mobile User Guide 

Trimble Connect Sync User Guide 

Account Administration Dashboard User Guide 

Trimble Connect Revit Add-In New

https://drive.google.com/file/d/1JjnhrQtNLRXeOSLYKNojUrrhj6pdw2Li/view?usp=sharing
https://drive.google.com/file/d/1-vx8BgT1YfAjC2bi0LtFrj4Oww95pKnZ/view?usp=sharing
https://drive.google.com/file/d/15PeFaKqX_w2CMfmP8GodwQk0CWcfFujx/view?usp=sharing
https://drive.google.com/file/d/1I3MucfsjEwuCSOU7IhNdx3J7Lq5_BNyw/view?usp=sharing
https://drive.google.com/file/d/1IlZvRqpmCC-ZM7-bpaGbK-TNbhjwG54P/view?usp=sharing
https://drive.google.com/file/d/1_bYEqXp549qaDQv5WIqG5FzH7qlUE8MT/view?usp=sharing
https://drive.google.com/file/d/1ZLXjTA6NEOddFrY5uhbdUIpiVz2fncbN/view?usp=sharing
https://drive.google.com/file/d/15OzgnJ29b0PCXyXL9xyZpMIBBuGHMBOm/view?usp=sharing
https://drive.google.com/file/d/1Ce31jXPZVSz3QTPH-V5Cwy2XhRFwOLKO/view?usp=sharing
https://drive.google.com/file/d/1MmIEaH-z9LiceB1WzPhZ7Xx5x1koKAtP/view?usp=sharing
https://drive.google.com/file/d/1rD-ZbZl_98pWBuHP-_wL14MA5OhrDTmc/view?usp=sharing
https://drive.google.com/file/d/17uO_hUPGMH-MNUlSrv-Ii1XK1uzyL0tW/view?usp=sharing
https://drive.google.com/file/d/17R7BdpZcnQGnyuWuIS0UhSmJLAEF-Ddj/view?usp=sharing
https://drive.google.com/file/d/1N65xExM2NzSuPeeF_C9qHh5x6V4u0q8U/view?usp=sharing
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